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Copyright Notice 

No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, 
or translated into any computer language, in any form or by any means, without the express written 
permission of Puma Technology, Inc. 

Intellisync® is a registered trademark of Puma Technology, Inc. 

Nokia 9110 Communicator is a trademark of Nokia Corporation. 

All other company and product names are trademarks of their respective companies. 

© Copyright Puma Technology, Inc. 1998. All rights reserved. 

Puma Technology, Inc., 2550 North First Street, Suite 500, San Jose, CA 95131 
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END-USER NOTICE AND LICENCE AGREEMENT FROM PUMA TECHNOLOGY, INC. 

NOTICE TO END-USER: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT ("LICENCE"). 
INSTALLATION OR USE OF THE ENCLOSED PUMA SOFTWARE ("SOFTWARE") ON YOUR COMPUTER 
SYSTEM CONSTITUTES YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT AGREE TO THE 
TERMS OF THIS LICENCE, PROMPTLY DELETE THE SOFTWARE FROM YOUR COMPUTER SYSTEM, 
DESTROY ANY COPIES YOU MADE OF THE SOFTWARE OR ANY INSTALLATION DISKETTES OF THE 
SOFTWARE INCLUDED WITH YOUR SYSTEM, AND DISPOSE OF ALL WRITTEN MATERIALS IN YOUR 
POSSESSION REGARDING THE SOFTWARE. 

Licence Grant: In the case of PC Suite for Nokia 9110 Communicator Software, Puma grants to 
You, as an individual, a licence to install and use one copy of the Software on a single computer at a 
time. Your licence to use the Software is conditioned upon Your compliance with the terms of this 
Agreement. A Licence is required for each end-user of the Software. A Licence is required for each 
installation of the Software, unless the Software is ( i.) installed temporarily on a PC owned by a third 
party so that you can accomplish a file transfer, and (ii.) is immediately deleted from such PC. You 
may make one (1) copy of the Software for archival purposes only. 

Copyright: The Software is protected by United States copyright law and international treaty 
provisions. You acknowledge that no title to the intellectual property in the Software is transferred to 
You. You further acknowledge that title and full ownership rights to the Software will remain the 
exclusive property of Puma, and You will not acquire any rights to the Software except as expressly 
set forth in this licence. You agree that any copies of the Software will contain the same proprietary 
notices which appear on and in the Software. 

Prohibited Uses: Without obtaining prior written permission from Puma, You may not (a.) use, copy, 
modify, alter, or transfer the Software or documentation except as expressly provided in this Licence; 
(b.) translate, disassemble, decompile, reverse program or otherwise reverse engineer the Software; 
(c.) sublicense or lease the Software or its documentation; or (d.) use the Software in a multi-user, 
network, or multiple computer environment or in a rental, time sharing or computer service business. 
Without prejudice to any other rights, Puma may terminate this Licence if You fail to comply with its 
terms and conditions. In such event, You must destroy all copies of the Software. 

Limited Warranty: Puma warrants that the Software will perform substantially in accordance with 
the accompanying written materials for a period of thirty (30) days from the date of purchase. Any 
implied warranties relating to the Software are limited to such thirty (30) day period. 

End-User Remedies: If the Software does not conform to the "Limited Warranty" section above, 
Puma's entire liability and your sole and exclusive remedy shall be, at Puma's option, either to (a.) 
correct the error, or (b.) help you work around the error. The Limited Warranty is void if failure of 
the Software has resulted from accident, abuse, or misapplication. Any replacement software will be 
warranted for the remainder of the original Limited Warranty period. 
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No Other Warranties: PUMA DOES NOT WARRANT THAT THE SOFTWARE IS ERROR FREE, EXCEPT 
FOR THE EXPRESS LIMITED WARRANTY IN THE "LIMITED WARRANTY" SECTION. PUMA DISCLAIMS 
ALL OTHER WARRANTIES WITH RESPECT TO THE SOFTWARE, EITHER EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. SOME JURISDICTIONS 
DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS OF HOW LONG AN 
IMPLIED WARRANTY MAY LAST, OR THE EXCLUSION OF LIMITATION OF INCIDENTAL DAMAGES, 
SO THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU. THIS WARRANTY GIVES 
YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM 
JURISDICTION TO JURISDICTION. 

No Liability for Consequential Damages: IN NO EVENT SHALL PUMA BE LIABLE TO YOU FOR ANY 
CONSEQUENTIAL, SPECIAL, INCIDENTAL, OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF 
THE PERFORMANCE OR USE OF THE SOFTWARE, EVEN IF PUMA HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. 

U.S. Government Restricted Rights: Use, duplication or disclosure of the Software by any agency, 
department or other entity of the Government is restricted in accordance with FAR 12.212 for civilian 
agencies and DFARS 227.7202 for military agencies. The Software is a commercial product. Use of 
the Software by the Government is further restricted by the terms of this Licence. 

Page iv 

Verizon Wireless 
Exhibit 1035-0004 



Table of Contents 

CHAPTER 1 : BEFORE YOU BEGIN ................................... ! 

INTRODUCTION TO PC SUITE FOR NOKIA 9110 
COMMUNICATOR ..................................................................... 2 

System Requirements ......................................................... 3 
Installing the Software ........................................................ 3 
Program Icons .................................................................... 5 
The Opening Screen ........................................................... 6 
PC Suite Menu Commands ................................................. 6 
Shortcut Commands ........................................................... 6 
Component Icons ................................................................ 7 
The Preferences Dialogue ................................................... 8 
Communicator Recognition ................................................ 9 
Preparing Your Communicator for a Data Transfer .......... 11 
Desk Stand Button Settings .............................................. 11 

CHAPTER 2: THE CONTACTS APPLICATION .............. 13 

USING THE CONTACTS APPLICATION ...................................... 14 
The Contacts Main Screen ................................................ 14 
Opening and Saving a Database ....................................... 15 
Creating a Contact Card Template .................................... 15 
Adding Contact Cards ...................................................... 16 
Card Menu Commands ..................................................... 16 
Editing Contact Cards ...................................................... 17 
Editing Contact Card Fields ............................................. 17 
Adding Pictures to Contact Cards ..................................... 20 
Creating and Editing Contact Groups ............................... 21 
Finding and Filtering Contact Information ....................... 22 
Importing Records from Another Database ....................... 26 
Updating to your Communicator ....................................... 27 
Updating from your Communicator .................................. 27 
Synchronising your Contacts ............................................ 28 

CONTACTS MENU COMMANDS ............................................... 29 

Pagev 

Verizon Wireless 
Exhibit 1035-0005 



Page vi 

CHAPTER 3: INTELLISYNC ............................................. 33 

QUICK START TUTORIAL ........................................................ 34 
Synchronising Data .......................................................... 34 
Re-Running the Operation ................................................ 40 
Taskbar Synchronisation .................................................. 40 

INTELLISYNC ADVANCED SETTINGS DIALOGUES ..................... 42 
Advanced Settings Tabs .................................................... 42 
The Date Range Tab ......................................................... 43 
The Field Mapping Dialogue ............................................ 61 

INTELLISYNC SPECIAL TOPICS ................................................ 65 
Synchronisation and History Files ..................................... 66 
Intellisync Address Formats .............................................. 67 
Importing and Exporting Data .......................................... 70 
Synchronisation and Data Truncation ............................... 71 
Full Re-Synchronisation ................................................... 72 
The Same Record Changed and Deleted Dialogue ............ 73 
The Sync Log File ............................................................ 74 
Remote Synchronisation ................................................... 76 

INTELLISYNC GLOSSARY ........................................................ 77 
INTELLISYNC MENU COMMANDS ............................................ 82 

CHAPTER4: FILE TRANSFERFUNCTIONS .................. 85 

USING THE FILE TRANSFER FUNCTIONS .................................. 86 
File Transfer Window Panes ............................................. 87 
Selecting Files .................................................................. 87 
Copying Files and Folders ................................................ 87 
Moving Files and Folders ................................................. 88 
Deleting Files and Folders ................................................ 89 
Renaming Files and Folders .............................................. 89 
File Properties .................................................................. 90 

FILE TRANSFER MENU COMMANDS ........................................ 91 

CHAPTERS: BACKUP AND RESTORE ........................... 93 

BACKING UP YOUR DATA ...................................................... 94 
RESTORING A BACKUP ........................................................... 97 
BACKUP/RESTORE MENU COMMANDS .................................... 99 

Verizon Wireless 
Exhibit 1035-0006 



CHAPTER 6 : INSTALLING AND REMOVING 
SOFTWARE ........................................................................ 101 

INSTALLING SOFTWARE TO YOUR COMMUNICATOR ............... 102 
REMOVING SOFTWARE FROM YOUR COMMUNICATOR ............ 103 
INSTALL/REMOVE MENU COMMANDS ................................... 104 

CHAPTER 7 : IMPORTING AND EXPORTING 
CALENDAR AND CONTACTS FILES .............................. 105 

THE IMPORT/EXPORT COMMANDS ........................................ 106 
EXPORTING A CALENDAR OR CONTACTS FILE TO YOUR PC .... 107 
IMPORTING A CALENDAR OR CONTACTS FILE FROM YOUR PC 

TO YOUR COMMUNICATOR ................................................... 109 
Importing a ContactsFile ............................................... llO 

IMPORT/EXPORT MENU COMMANDS .................................... 111 
INDEX ................................................................................. 112 

Notice: The contents of this manual reflect the PC Suite for 
Nokia 9110 Communicator program at press-time. For 
information about changes to the software (or system support) 
that may have occurred since the manual was printed, refer to 
the Readme file or on-line Help. 

Page vii 

Verizon Wireless 
Exhibit 1 035-0007 



Verizon Wireless 
Exhibit 1035-0008 

Verizon Wireless

Exhibit 1035-0008



Before You Begin 

Chapter 1 : Before You Begin 

This chapter introduces PC SJite for Nokia 9110 
Communi cat or and instructs you on how to get 
started using the software. 

Topics include: 

+ Introduction to PC Suite for Nokia 9110 Communicator 

+ System Requirements 

+ Installing the Software 

+ Program Icons 

+ The Opening Screen 

+ PC Suite Menu Commands 

+ Shortcut Commands 

+ Component Icons 

+ Before Configuration 

+ The Preferences Dialogue 

+ Communicator Recognition 

+ Preparing Your Communicator for a Data Transfer 

+ Desk Stand Button Settings 
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PC Suite for Nokia 9110 Communicator 

Introduction to PC Suite for Nokia 9110 
Communicator 

Page 2 

PC Suite for Nokia 9110 Communicator is a suite of functions 
that allow for the easy transfer of data between your Nokia 9110 
Communicator and the PC applications you rely on most. 

+ PC Suite's Intellisync® component lets you synchronise 
your Nokia 9110 Communicator's Contacts, Calendar, and 
To-do list applications with a host of popular Windows 
applications. 

+ The Contacts application provides a PC Contacts file that is 
compatible, field-for-field, with your communicator's 
Contacts application. 

+ The Backup/Restore component lets you back up the data 
on your Nokia 9110 Communicator for safe keeping, and 
restore it if need be. 

+ Import/Export functions import and export Calendar and 
Contacts files between your communicator and PC. 

+ The Install/Remove component installs software to and 
removes software from your communicator. 

+ File Transfer functions let you select, move, copy, paste, 
rename, and delete communicator or PC files in a Windows 
Explorer-type environment. 
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Before You Begin 

System Requirements 
In order to use PC Suite for Nokia 9110 Communicator, your 
PC must meet the following minimum system requirements: 

• Windows 95, Windows NT 4.0 

• IBM-compatible 486 PC or higher 

• 15MB available hard disk space 

• VGA monitor or better 

• CD ROM drive 

• One available serial or infrared port 

Installing the Software 

Follow these steps to install the PC Suite software on your PC: 

1. Insert your CD into your CD ROM drive. The program 
should launch itself automatically. If it does not, continue 
following these instructions. 

2. Click the Windows Start button; then click Run. 

3. Type d:\9110.exe in the command line (substitute the letter 
"d" with the letter of your CD drive). 

4. Press Enter. 

5. A series of screens is presented. Follow on-screen 
instructions, and note: 

+ You are asked to specify the PC COM port you will use to 
connect your communicator to your PC. If you will be 
connecting via infrared, check the box labelled Infrared 
Port. 
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PC Suite for Nokia 9110 Communicator 
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+ You are given the option of performing a Complete or 
Custom installation. If you choose Custom, you are 
presented with a screen labelled Select Components. This 
screen lists the PC applications supported by the PC suite 
Intellisync function. Un-checking an application in this 
screen removes support for that system. (Thus, cutting down 
on the disk space used by PC Suite.) 

Note: If you un-check a PC application in this screen, but 
later want to restore support for that system, re-install PC 
Suite and check the application in the Select Components 
screen. (Don't un-install Intellisync before re-installing.) To 
avoid losing custom settings (including field mapping) un­
check PC Suite Program Files in the Select Components 
screen. A re-installation of the software is the only case in 
which you should un-check PC Suite Program Files. 

When installation is complete, a program group containing a set 
of PC Suite icons will have been created . 

.,_ To access the program group, click Programs on the 
Windows Start menu. Then click on PC Suite for Nokia 
9110 Communicator. 
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Before You Begin 

Program Icons 

When you install the PC Suite for Nokia 9110 Communicator 
software, a set of icons is created. 

The PC Suite for Nokia 9110 Communicator 
icon accesses the PC Suite opening screen. 

The Help icon accesses the on-line Help system. 

The Readme icon displays a text file containing 
last-minute information not included in the 
manual or Help topics. 

The Uninstall icon can be used to remove the PC 
Suite software from your PC. 
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PC Suite for Nokia 9110 Communicator 

The first time you 
open the PC Suite 
application, the 
Contacts component 
is open. Thereafter, 
the last-visited PC 
Suite component is 
open when you start 
the software. 
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The Opening Screen 
9.-1.1.1!1 

Click the lmml PC Suite for Nokia 9110 Communicator icon in 
the PC Suite program group to start the PC Suite software. From 
the opening screen, all PC Suite components can be accessed via 
icons or menu commands. 

H Q§ffl§MI MMIF"' . '''"'•' N4 

c 
lrtell<:ync 

~ 
File 

Trar1sler 
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lml-!!1/ 
Remove 
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= PC Suite 

D 

PC Suite Menu Commands 
Each PC Suite component displays its own set of command 
menus at the top of the screen. Refer to the component-specific 
sections of this manual for information on the menus that apply 
to each component. 

Shortcut Commands 
Most PC Suite commands that are executed by mouse-clicking 
on a button or menu item can also be initiated from your 
keyboard. Simply hold down the Alt key and press the letter 
that is underlined in the button or menu item. 
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Note that you can 
"drag and drop" 
component icons to 
re-order them on the 
PC Suite screen. 

Before You Begin 

Component Icons 

Component icons are located on the left side of the PC Suite 
opening screen. These work as follows: 

The Contacts icon starts the Contacts application, 
which installs with PC Suite to provide field-for­
field compatibility with your Nokia 9110 
Communicator's Contacts application. 

The Synchronise icon accesses the Intellisync 
component, which synchronises, imports, or exports 
data between records in your communicator and PC 
application. 

The Import/Export icon accesses the PC Suite 
Import/Export function, which transfers Calendar 
and Contacts files between your communicator and 
your PC. 

The Backup/Restore icon accesses PC Suite's 
Backup and Restore functions, which can be used 
to backup and, if need be, restore, the data on your 
Nokia 9110 Communicator. 

The Install/Remove icon accesses PC Suite's 
Install/Remove component, which can install 
software to, and remove software from, your Nokia 
9110 Communicator's main memory or memory 
card .. 
The File Transfer icon displays a Windows 
Explorer-type dialogue that lets you cut, copy, 
paste, and move files between your communicator 
and your PC. 
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PC Suite for Nokia 9110 Communicator 
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The Preferences Dialogue 
Selecting the Preferences command from the PC Suite Options 
menu displays the Preferences dialogue. Before using PC Suite, 
make sure the settings in this dialogue are configured correctly. 

+ Select the radio button labelled Serial Cable if you are using 
a serial cable to connect your communicator to your PC. 

+ Select Infrared if you are using infrared communication. 

+ The Communications Port setting specifies the COM port 
you are using to connect your communicator to your PC. If 
you are using infrared, make sure you specify the port that is 
assigned for infrared connection. 
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Before You Begin 

Communicator Recognition 
PC Suite functions allow you to configure operations-for 
example, Backup and Intellisync Synchronisations-for 
multiple communicators. 

Because each Nokia 9110 Communicator has a unique I D 
number, PC Suite for Nokia 9110 Communicator has the ability 
to recognise individual communicators when they are connected 
to your PC. 

To configure an operation for a particular communicator, you 
simply connect the communicator to your PC (or establish an 
infrared connection) and configure an operation. Thereafter, 
any time you connect that communicator and give a PC Suite 
command to run a configured operation, PC Suite recognises 
the communicator and runs the operation defined for that 
communicator. 

Naming your Communicator 

The very first time you connect a particular communicator to 
your PC-whether by serial cable or via infrared-PC Suite 
asks you for a Name to associate with the communicator. 

Register New Communicator • 

Ci:Jmm~AniE:atGn'.J[I: 
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PC Suite for Nokia 9110 Communicator 

Deleting a 
communicator 
name in this 
dialogue deletes all 
files and settings 
associated with 
that communicator. 

Page 10 

Assigning a name to each communicator allows PC Suite to 
associate each communicator (and the operations that are 
configured for that communicator) with a value that is more 
easily recognised than the communicator's ID number. 

Pressing the View button in this prompt displays the 
"Registered Communicators" dialogue, which lists the 
communicators, if any, that have been connected and named. 

This dialogue can be used to rename a communicator, or delete 
a communicator from the list of recognised communicators. 

Note: The Registered Communicators dialogue can also be 
accessed from the Options menu. 
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Refer to "The 
Preferences 
Dialogue" in this 
chapter for 
information on the 
PC Suite COM port 
setting. 

Before You Begin 

Preparing Your Communicator 
for a Data Transfer 
PC Suite data transfer operations can occur via serial cable or 
infrared connection. 

To prepare your communicator for a data transfer via serial 
cable: Connect your serial cable to your communicator and to 
the appropriate PC COM port. If you are using a desk stand, 
place your communicator in its desk stand with the desk stand 
serial cable connected to your PC COM port. 

To prepare your communicator for a data transfer via 
infrared: Press the System button on your communicator. Select 
IR activation on the System menu. Then point your 
communicator at your PC infrared port or adapter. 

Desk Stand Button Settings 

If you use a desk stand, you can program the desk stand 
synchronisation button to run the currently configured Backup 
and/or Synchronise operation whenever the program is active. 

Click Desk Stand Button Settings in the Options menu to 
display the following dialogue: 
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Desk stand button E3 

Operations to perform:-------~ 

.fu!nchronize 

Cancel !:ielp 

This dialogue contains check boxes labelled Backup and 
Synchronise. Neither is checked by default. 

+ Check Backup if you want the desk stand synchronisation 
button to run the currently configured Backup operation. 

+ Check Synchronise if you want the desk stand 
synchronisation button to run the currently configured 
Intellisync operation. 

If you check both Backup and Synchronise, both operations 
are performed when you click the desk stand synchronisation 
button, with the Backup operation occurring first. 

Click OK to save your selection(s) and exit the dialogue. 
Clicking Cancel exits the dialogue without saving. 

Verizon Wireless 
Exhibit 1 035-0020 



The Contacts Application 

Chapter 2 ·The Contacts Application 

PC SJi te for Nokia 911 0 Corrrnuni cat or's 
Contacts component lets you create, edit, and 
update contact cards I ike those on your Nokia 
911 0 Communicator, and transfer them between 
your PC and your communicator. 

Topics in this chapter include: 

+ Using the Contacts Application 

+ The Contacts Main Screen 

+ Opening and Saving a Database 

+ Creating a Contact Card Template 

+ Adding Contact Cards 

+ Card Menu Commands 

+ Editing Contact Cards 

+ Editing Contact Card Fields 

+ Adding Pictures to Contact Cards 

+ Creating and Editing Contact Groups 

+ Finding and Filtering Contact Information 

+ Importing Records from Another Database 

+ Updating to your Communicator 

+ Updating from your Communicator 

+ Synchronising your Contacts 

+ Contacts Menu Commands 
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PC Suite for Nokia 9110 Communicator 

Using the Contacts Application 

To sort cards 
alphabetically by name, 
click on the Name 
heading in the lower 
part of the screen. 

Clicking the Name 
heading toggles 
between alphabetical 
and reverse­
alphabetical order. 

To sort records similarly 
by Company, click the 
Company heading. 

Page 14 

PC Suite for Nokia 9110 Communicator's Contacts application 
lets you create, edit, and update contact cards like those on your 
Nokia 9110 Communicator, and transfer them between your PC 
and your communicator. 

The Contacts Main Screen 
To access the Contacts application, click on the Contacts icon 
in the PC Suite opening screen. 

XWJ PC Surte lor Nokia 9110 Communrcalor - ContactS: li!ilif £j 
Eile ~i e~J.J _Card Fi~ !mage §roup~ Ioo l~ Component:;: _Qptiom Help 

a 
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lntelli:>ync 

t% 
File 

Tr -Ylsfer 

Backup I 
Restore 

~ 
lnct~l/ 
Remove 

l~r t / 
Export 

NCKIA 

RMdy 

I Contacts 

Name: James Moose 
Company: Moose Landscaping Ltd 

Job title: President 
Address: 22 Madeline court 

Tel (GSM): 916 555-3356 
Fax: 

Fax (GSM): 
Mail: 
Note: 
URL: 

Co • 
Moosel~ndsc .'l pingltd 

ZiffeiErtlerprises 

PC Suite 

D 

The Contacts main screen contains two windows. The lower 
window contains all the contact cards in the selected database. 
The top window shows the open contact card. 

To open a contact card, click on a Contact name in the lower 
window. 
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When you save a 
database, attached 
.JPG and .BMP 
image files are saved 
in a sub-directory. 
(Both .JPG and .BMP 
images saved in this 
sub-directory are 
converted to 16 bit 
grey scale JPEG 
format files.) 

Changing the Contact 
card template does 
not affect the form of 
existing cards. 

Note that menu 
options are 
sometimes disabled in 
the Field menu. For 
example, when the 
Name field is 
selected, Change 
Label and Delete are 
not available because 
you are not allowed to 
delete or rename the 
Name field. 

The Contacts Application 

Opening and Saving a Database 
To create a new Contacts database, or open an existing 
database, click Open on the File menu and specify a database 
name and location. Use File/Save or File/Save As to save the 
current database. 

Creating a Contact Card Template 
Before you start creating Contact cards, you may want to alter 
the default Contact card template. 

Follow these steps to create a template for the Contact cards you 
will create in Contacts: 

1. Open the Card menu at the top of the Contacts main 
screen, and select Template to display the default Contact 
card template. 

Nome: Card template 
Company: 

Job title: 
Address: 

Tel (GSM): 
Fax: 

Fox (GSM): 
Mail: 
Note: 
URL: 

Password: 
Member: 

D 

2. In this template, you can add fields, renarre fields, or 
delete fields from the default template. Simply select a field 
in the template and open the Field menu. 

Field menu options include Change Label, Add, and 
Delete. 

When the template is as you want it, you are ready to add new 
Contact cards to Contacts. 
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Adding Contact Cards 
Follow these steps to create a new Contact card: 

1. Click Card to open the Card menu. 

2. Click New. This displays an empty Contact card (based on 
the current template) in the top window. 

3. Fill out the card. Use the Enter key or up and down arrow 
keys to move between fields in the card template. (Note 
that as soon as you enter a Name value and move to 
another field, the new Contact card appears in the lower 
window. 

4. Repeat these steps for each card you want to create. 

5. To save the new cards you've created, use the File/Save 
command. 

Card Menu Commands 
As described, the Template and New commands on the 
Contacts Card menu let you create a Contact card template and 
create new cards using the current template. 

The complete set of Card menu commands is as follows: 

+ New: Lets you create a new Contact card. 

+ Delete: Deletes the open Contact card, or the Contact card 
selected in the Contacts directory portion of the screen. 

+ Duplicate: Copies the currently selected Contact card. 

+ Copy Contents: Copies the contents of the currently 
selected card to the Windows clipboard. 

+ Template: Displays the current Contact card template. 
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The Contacts Application 

Editing Contact Cards 
Editing Contacts cards in the Contacts application is easy. 
Simply select the card you want to edit, select the field whose 
value you want to change, and re-type the value. 

Editing Contact Card Fields 
You can also use the Field menu to edit the fields list for a 
particular card. Field menu commands include Change Label, 
Add, and Delete. 

Changing a Field Label 

The Change Label command on the Field menu lets you 
change the current field label to a label selected in a displayed 
list. 

Note the text entry field at the lower right comer of list box. 
Typing a value here adds a parenthetical to the value selected in 
the list. 

When you've specified the field label you want to use, click OK 
to redisplay the Contact card. 
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PC Suite for Nokia 9110 Communicator 

See "The Add Field 
Labels List," next, for 
more information on 
the list of fields that 
you can select. 
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Note that you cannot change some field labels (e.g., Name, 
Company). When such fields are selected, the Change Label 
menu option is disabled. 

Adding a Field 
The Add command on the Field menu lets you add fields to the 
open Contact card. When you give the Add command, a list of 
fields displays. 

Add field label 13 

Tel 
Fax 
Tel/Fax 
Mail 
DTMF 
URL 
Ring tone 

Note the text entry box at the lower right comer of the Add 
field dialogue. Typing a value here adds a parenthetical value to 
the field selected in the list-for example, Address (Business). 

Once you've selected a field in this list, click OK to add the 
field to the open Contact card. Clicking Cancel exits without 
adding a field. 
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The Contacts Application 

The Add Field List 

The Add Field List contains the following fields: 

Company The name of the company where the contact works. 

Job title The job title of the contact. 

Address The address of the contact. 

Tel The telephone number of the contact. 

Fax The fax number of the contact. 

Tel/Fax If the contact has one phone number for both the 
telephone and the fax machine, write the number 
here. 

Mail The e-mail address of the contact. 

DTMF The DTMF (dial tone message format) string 
needed for communicating with the contact. 

Note You can add important information such as 
birthday or office hours in this field. 

URL The WWW address of the contact. 

Password The calendar booking password of the contact. 

Ringing tone The individual ringing tone set for the contact in 
the Nokia 9110 Communicator. Note that if you set 
an individual ringing tone to one that does not 
exist on the communicator, the default tone is 
played. 

Member The group( s) in which the contact is a member. 

Deleting a Field 
To delete a field from the open Contact card, highlight the field 
and give the File/Delete command. 

Page 19 

Verizon Wireless 
Exhibit 1 035-0027 



PC Suite for Nokia 9110 Communicator 

Page 20 

Adding Pictures to Contact Cards 
The Contacts application lets you add pictures to your Contact 
cards. A picture must first be stored on the PC in the .JPG or 
.BMP format. 

To add a picture to the open Contact card, click on the picture 
frame at the upper right comer of the Contact card, or click 
Image and select Add. This displays a Choose Image dialogue. 

Choo•e image 

In this dialogue, use standard Windows file location methods to 
find the file containing the picture you want to use. To select 
the picture file, highlight the filename and click Open. Then 
click OK to add the picture to the card. 

If you want to add just a section of a picture to the card, use 
your mouse to select a rectangular portion of the picture before 
clicking the OK button. 

Removing Pictures from Contacts Cards 
To remove a picture from the opened contact card, click Image 
and select Delete. 

Verizon Wireless 
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The Contacts Application 

Creating and Editing Contact 
Groups 
By default, Contact cards have a Member field. This field 
allows you to specify a group that the contact belongs to. 

When you place the cursor in the Member field, a Select Group 
dialogue is displayed, listing the groups that are currently 
defined. To select from this list, highlight a group name and 
click OK. 

To add to or change the Contact Group list, open the Groups 
menu and select Edit. This displays the Contact Group 

Cnntacl gmups 

Documentation 
Engineering 
Marketing 
Public Relations 

dialogue. 

+ To add a new group to this list: Click the New button and 
type a new Group name when prompted. Then click OK. 

+ To assign a group in this list to the open Contact card: 
Highlight the group name and click Select. 
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+ To remove a group from the Contact Group list: 
Highlight the Group name and click Delete. 

Finding and Filtering Contact 
Information 
The Contacts application's Tools menu contains commands 
that let you find and filter Contacts information. 

Finding a Contact 

To quickly find a Contact card, you can search for any text 
string using the Find command on the Tools menu. 

Open the Tools menu and click Find. Then enter a string to be 
searched for. 

When the string is located, the cards are resorted, and the 
Contact card containing the string is moved to the top of the list 
and displayed. If the string occurs in more than one card, 
additional cards containing the specified string are listed 
immediately below the displayed card. 

Getting Contact I nformati on 

Giving the Contact info command on the Tools menu displays 
a dialogue containing general information about the currently 
open database-e.g., the number of records, the number of 
defined groups, etc. 
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The text field is 
case insensitive; 
that is, capital 
and lower-case 
letters are 
treated equally. 

The Contacts Application 

Filtering Contacts into a New Database 
The Filter connnand on the Tools menu is an efficient and 
versatile tool for filtering contacts from a large database into 
another database. 

You can create search criteria row by row, and you can control 
the relationships between the criteria with the logical operators 
AND, OR, and NOT, and with parentheses. You can add as 
many search criteria as you want. 

Search Criteria 
At its simplest, a search criterion can be as follows: 

Field= text 

To create a search criterion, you select the name of a Contact 
card field from the Field list, and type in some text. For 
example: 

Company = Bankers Ltd. 

With this search criterion, all Contact cards that have Bankers 
Ltd. in the Company field would be fetched from the database. 

You can also add wildcards (?) and (*) into the text criterion. 

? corresponds to any single character. For example: 

Name= ?im 

finds all Contact cards in which the Name field begins with any 
character and ends with i m (i.e. Kim, Tim, etc.). 

* corresponds to any string of characters. For example: 

Company = Bank* 

searches for Contact cards in which the Company field begins 
with Bank (i.e. Bankers Ltd., Banking, Bank:Saving). 
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You can also select an asterisk (*) as the Contact field. For 
example: 

*=Bank* 

finds Contact cards in which any field begins with Bank. 

Using the Logical Operators 

The logical operators NOT, AND, and OR allow you to create 
more complex filters. 

+ NOT negates the search criterion. For example: 

NOT Company = Bankers Ltd. 

searches for all Contact cards in which the Company is not 
Bankers Ltd. 

+ AND joins two search criteria together, so that both of 
them apply to the search. For example: 

Name= James 
AND Company = Bankers Ltd. 

finds all Contact cards in which the Name is Jarres and the 
Company is Bankers Ltd. 

+ OR joins two search criteria together, but only one of them 
needs to be true for a Contact card to be selected. For 
example: 

Name= James 
OR Company = Bankers Ltd. 

searches for Contact cards in which the Name is Jarres or 
the Company is Bankers Ltd. 
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Parentheses can be 
added to filters using 
the second and last 
input fields. 

The Contacts Application 

Using Parentheses 

Using parentheses, you can combine search criteria. For 
example: 

Name= James 
AND (Company = Bankers Ltd. OR Company = Global Air) 

finds all the contacts named Jarres who work either for Bankers 
or Global Air. 

Note: The closing parenthesis is selected in the input field 
located on the far right of the Filter contacts dialogue. Note, 
however, that it only becomes available when a starting 
parenthesis is selected. 

To Use Filtering 

When you open the Filter contacts dialogue, the first row gives 
an example of a search criterion: 

Name=* 

This matches all Name fields in the database. Edit this sample 
criterion using the following steps. Then add additional criteria 
as needed. 

To edit or create a criterion: 

1. If necessary, select a logical operator on the far left. In the 
first row, you can only select NOT. 

2. In the Field colunm, select a field or a wildcard character. 

3. Enter text (and/or wildcards) in the text input field. 

To create new search criteria, use the Insert key. Remove 
existing ones with the Delete key. 
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Executing the Filter 

The open database is the source file from which records will be 
filtered. To open a different database, click the Browse button 
and select a new file. 

Click the Filter button to perform the filtering operation. When 
the filtering is complete, the results, displayed in a separate 
window, can be saved. 

Note that if you save the filtered records to an existing file, the 
contents of the file are overwritten (you are prompted to 
confirm the overwrite). 

Note: Pictures (.JPG or .BMP files) are saved in a Contact 
images subfolder of the database you save. 

Importing Records from Another 
Database 
The Contacts application lets you add records from one 
Contacts database into another. Simply give the Import from 
file command on the File menu and specify a file. The records 
(including images) in the file you choose will be added to the 
open database. 
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Refer to 
"Synchronising Your 
Contacts" later in 
this chapter for more 
information on how 
the "Update" 
commands work. 

The Contacts Application 

Updating to your Communicator 
The Contacts application's File/Update to Communicator 
command updates your communicator with records from the 
open database. That is, records in the open database that are not 
already contained in your communicator are added to the 
communicator. 

Follow these steps: 

1. Start Contacts and open the Contacts database that contains 
the records you want transferred to your communicator. 

2. Connect your communicator to your PC COM port or 
establish an infrared connection. 

If you're prompted to do so, enter a name for your 
communicator. 

3. Open the File menu and click Update to Communicator. 

Updating from your 
Communicator 
The Contacts application's File/Update from Communicator 
command updates the open Contacts database with records 
from your communicator. That is, records in your 
communicator that are not already contained in the open 
database are added to the database. 

Follow these steps: 

1. Start Contacts and open the database that you want 
updated. 

2. Connect your communicator to your PC COM port or 
establish an infrared connection. If you're prompted to do 
so, enter a name for your communicator. 

3. Open the File menu and click Update from 
Communicator. 
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Synchronising your Contacts 
If you were to give the Update to Communicator and Update 
From Communicator commands one after the other, each of 
your systems would contain the same set of Contact records. 
However, synchronising records in this fashion can result in the 
creation of "duplicate" records. 

Why? During the updating process, records in your two systems 
are compared. If a record in the system you are updating from is 
not identical, field for field, to a record in the other system, it is 
transferred. This means, for example, that if each of your 
systems has a Contact card for John Johansen, but the phone 
numbers in the two cards are different, a duplicate card 
(containing a different phone number) is created in the target 
system when you give the "Update" command. 

If you want to synchronise your Contact records and avoid the 
possibility of creating duplicate records, use the Intellisync 
synchronisation function described in Chapter 3. 
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Contacts Menu Commands 

FILE 

Open 

Save 

Save As 

Import from file 

Update to 
communicator 

Update from 
communicator 

Exit 

VIEW 

Status Bar 

CARD 

New 

Delete 

Duplicate 

Copy Contacts 

Template 

The Contacts Application 

Opens a Contacts database. 

Saves the open database. 

Saves the open database to a given 
location. 

I rrports records from another file into the 
open database. 

Updates oomrnmicator with records in the 
open database. 

Updates the open database with Contact 
records from your communi cat or. 

Exits PC &lite. 

Toggles status bar on and off. I 

Creates a new Contact card. 

Deletes the open Contact card. 

Copies the open Contact card. 

Copies the contents of the open card to 
the WIndows Clipboard. 

Lets you change the default Contact card 
template. 
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FIELD 

Change label 

Add 

Delete 

IMAGE 

Add 

Delete 

I GROUPS 

Edit 

TOOLS 

Find 

Contact Info 

Filter Contacts 
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Lets you change the selected field 
label. 

Lets you add a field to the open 
Contact card. 

Deletes the field selected in the open 
Contact card. 

Lets you add a picture to the open 
Contact card. 

Deletes the picture from the open card. 

I Lets you edit the Groups list. 

Lets you find a Contact card containing a 
given string. 

Slows you how much data is in the open 
database. 

Lets you conduct an advanced search of 
the open database, and save" matching" 
records to another database. 
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COMPONENTS 

Contacts 

Intellisync 

File Transfer 

Backup/Restore 

Install/Remove 

Import/Export 

OPTIONS 

Desk Stand Button 
Settings 

Registered 
Communicators 

Preferences 

HELP 

Contents 

Commands 

Using Help 

About PC Suite 

The Contacts Application 

S:arts Contacts application corrponent. 

Accesses I ntell i sync corrponent. 

Accesses File Transfer oomponent. 

Accesses Backup/Restore corrponent. 

Accesses I nstall /Remove corrponent. 

Accesses I rrport/Export corrponent. 

Displays desk stand button options. 

Lists the communicators that have 
been connected and named. 

Displays the Preferences Dialogue. 

Displays on-I ine Help Contents. 

Displays command information. 

Accesses Help for on-line Help. 

Displays" About PC &lite" dialogue. 
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Intellisync 

Chapter 3 : lntellisync 

I ntell i sync's Sfnchroni sati on function compares 
records in your Nokia 911 0 Communicator to 
records in your PC application. It then makes 
whatever changes are necessary in each system to 
ensure that each contains the same up-to-date 
i nfor mati on. 

This chapter ex:pl ai ns how I ntell i sync works, and 
guides you, step-by-step, through the process of 
running your first synchronisation. 

SEdi ons include: 

+ Quick Start Tutorial 

+ Intellisync Advanced Settings Dialogues 

+ Intellisync Special Topics 

+ Intellisync Glossary 

+ Intellisync Menu Commands 
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Quick Start Tutorial 

Refer to 
"Synchronisation 
and History Files" 
under" lntellisync 
Special Topics" for 
information on how 
synchronisation is 
achieved. 

See "Importing and 
Exporting Data" in 
"lntellisync Special 
Topics" for 
information specific 
to lntellisync Import 
and Export 
operations. 

Refer to 
"Communicator 
Recognition" in 
Chapter 1 for 
information on how 
you can use PC 
Suite for Nokia 9110 
Communicator with 
multiple 
communicators. 
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This "Quick Start" tutorial describes the most basic Intellisync 
dialogues, and guides you through the process of setting up and 
running your first Intellisync synchronisation. For information 
about Intellisync "Advanced Settings," refer to "Intellisync 
Advanced Settings Dialogues" later in this chapter. 

Note: For simplicity, this tutorial emphasises synchronisation. 
However, the steps shown here can also be used to configure 
Intellisync imports and exports of data. The only difference is in 
the choice of a button in the lntellisync Choose Translator 
dialogue. 

Synchronising Data 
Intellisync is designed to simplify the synchronisation of data 
between your communicator and your PC. Synchronisation can 
be accomplished with little more than the press of a button. 
Before you can execute an operation for the first time, however, 
you must configure the operation you want to perform. 

Once you have set up your configuration parameters for a 
particular communicator, you never need to configure again 
unless you want to change the nature of the operation. 

Verizon Wireless 
Exhibit 1035-0042 



Before starting this 
tutorial, read 
"lntellisync Address 
Formats" under 
"lntellisync Special 
Topics" in this chapter. 

Refer to "Remote 
Synchronisation" 
under" lntellisync 
Special Topics" 
for information 
about performing 
remote 
synchronisations. 

Follow these steps to set up and perlorm your first 
synchronisation: 

Intellisync 

1. Click the PC Suite for Nokia 9110 Communicator icon in 
the PC Suite program folder to display the PC Suite opening 
screen. 

2. Click the Intellisync icon on the opening screen to access 

a lntellisync 

c S)."Cttcrize Dal:a 

lii eli:::yoc 

T~ 

_io lx! 

PC Suite 

Intellisync. The Local tab is selected by default. 

3. Connect your communicator's serial cable to the appropriate 
PC COM port. (If you're using a desk stand, place your 
communicator into its desk stand.) If you're using infrared, 
establish an infrared connection between your communicator 
and PC. 

If you're prompted to do so, enter a name for your 
communicator. 

4. Click the Settings button. 
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Refer to "Address 
Formats" under 
"lntellisync Special 
Topics" for complete 
information on 
selecting an Address 
Format-including 
what you should do if 
none of the formats 
correspond to the 
formatting of your 
data. 
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5. You may be presented with a dialogue containing the tabs 
Format and File. This dialogue only displays the first time 
you configure an operation for a particular communicator. 
(Thereafter you can change settings in this dialogue using 
the Contacts command on the Options menu.) 

+ In the Format tab, select the address format that you are 
using for addresses in your communicator (see margin 
note). 

+ In the File tab, indicate if you want to synchronise 
Contacts on the communicator's main memory, or on 
the Memory card. If you choose the latter, specify the 
file you want synchronised. 

When you've made your selections, click OK to display the 
Configuration dialogue. 

PC Suite For Nokia 911 0 Communicator Confrgurahon 13 

P" ~ C-alendar 

P" ill! Contact< Format 4 

The Configuration dialogue contains an "Applications" list 
containing your communicator's Calendar, Contacts, and To-do 
list applications. 

6. Click on the Nokia 9110 Communicator application you 
want to configure. 

7. Click Choose to enter the Choose Translator dialogue. 

Verizon Wireless 
Exhibit 1035-0044 



When it's present, 
checking the Apply to 
all applications check 
box at the bottom of the 
Choose Translator 
dialogue configures all 
compatible Nokia 9110 
Communicator 
"applications" with the 
PC application and file 
you selected. If all of 
the data you want 
synchronised is in a 
single file or folder, 
check this option to 
configure all of your 
communicator's 
applications at once. 

For information 
about Options 
dialogue settings, 
click the Help button 
and refer to the 
Supported Systems 
on-line Help topic for 
the PC application 
you are using. 

Intellisync 

This dialogue lists all the PC applications that are compatible 
with the Nokia 9110 Communicator application you selected. 

<None> 
ASCII· Text Delimited 
Lotus Organizer GS-Notes 
Lotus Organizer GSHM 
MS Outlook 97/98 

MS Schedule+ Default 

8. Specify the application and (if necessary) the file you want to 
synchronise. (Use the Browse button for file selection to 
avoid making typos when typing in complicated paths.) 

Notes: 
• If you are synchronising with Outlook, you will specify a 

folder instead of a file. Use the Browse button for folder 
selection. 

• If you are synchronising with Schedule+ 7.0, you must 
select Schedule+ Default (you do not need to specify a file; 
the open or last used file is used by default). If you are 
using Schedule+ 7.0a or 7.5, you can select either 
Schedule+ Default or Schedule+ Browse File. However, 
if you want to select a file, you must select Schedule+ 
Browse File. Otherwise the open or last used file is 
selected automatically. 
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9. If necessary, select the operation you want to perform. 
Synchronise is normally selected by default. (Synchronise is 
not supported for ASCII- Text Delimited.) 

10. If the Options button is enabled, click it. This accesses 
special application-specific settings that apply to the selected 
PC application. If necessary, adjust settings in the Options 
dialogue. Then click OK. 

11. Click the OK button in the Choose Translator dialogue to 
return to the Configuration dialogue. 

PC Suite For Nokia 911 0 Communicator Confrgurahon 13 

IV ~ C-alendar <?=:> MS Schedule+ Browse 

r ill! Contact< Format 4 

Now the PC application you selected appears next to the 
communicator's application name, and a two-way arrow 
appears between the application names. (A one-way arrow 
appears if you selected Import or Export.) 

Note the check box adjacent to the highlighted applications. By 
default, this box is checked, indicating that the data is activated 
for synchronisation. (If you un-check this box, the data will not 
be synchronised.) 
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Refer to "lntellisync 
Advanced Settings 
Dialogues" later in this 
chapter for information 
on "Advanced" 
settings. 

Refer to "The Conflict 
Resolution Tab" under 
"lntellisync Advanced 
Settings Dialogues" 
for information on how 
to resolve data 
conflicts during 
synchronisations. See 
"The Confirmation 
Tab" in the same 
section for information 
on the confirmation 
prompt. 

Intellisync 

12. To review or alter settings or field mapping for a particular 
application, select the Advanced button to access the 
Intellisync Advanced Settings dialogue. (Intellisync provides 
default values for all "Advanced" settings.) 

Advanced Settings for Calendar [t3' 

Date Range 1 Confirmotion Conflict R esolut~n 

You ma_y choose to restrict the number of appointments or events transferred to 
future items only, or restrict to items that f al within a set range of days_ N ole 
.6.ppointments outsde of range will be removed from tf-e device 

Optioos=================rr 
. T r amfer All }cheduled items 

. Transfer items witf·ln aiange of Da_ys 

13. When you're ready to exit the Advanced Settings dialogue, 
click OK or Cancel. 

14. Repeat steps 6 through 13 for each Nokia 9110 
Communicator application you want to synchronise (not 
necessary if you checked Apply to all applications in the 
Choose Translator dialogue). 

15. When you're ready to perform the operation, click the OK 
button at the bottom of the Configuration dialogue. 

16. Click the Synchronise button on the Intellisync opening 
screen. 

17. If prompted, resolve data conflicts. 

18. A confirmation prompt appears, showing you how many 
adds, changes, and deletes will be applied to each of your 
systems if you proceed with the operation. Click Accept to 
proceed, or Cancel. 
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If you use a desk 
stand with your 
communicator, refer 
to "Desk Stand Button 
Settings" in Chapter 1 
for information on 
how you can program 
your desk stand 
synchronisation 
button to execute the 
currently configured 
lntellisync operation. 
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Intellisync History Files 

For each set of data you synchronise, a history file is used to 
determine the changes that must be made in each of your 
systems in order to achieve synchronisation. This file is created 
by the first synchronisation of the data. Therefore, a "first- run" 
synchronisation is different from (and may take longer than) 
subsequent synchronisations. A first-run synchronisation simply 
merges the contents of your two systems. The Conflict 
Resolution setting in the Advanced Settings dialogue is used to 
resolve conflicts between the systems. 

See "The Conflict Resolution Tab" under "Intellisync Advanced 
Settings Dialogues" for information on the Conflict Resolution 
setting. 

For information on how history files are used in the process of 
synchronisation, see "Synchronisation and History Files" under 
"Intellisync Special Topics." 

Re-Running the Operation 
Now that you have configured a synchronisation, re-executing 
the operation is basically a one-step operation. To re-run the 
operation, simply prepare your communicator for 
synchronisation and click the Synchronise button on the 
Intellisync opening screen. 

Taskbar Synchronisation 
To run a synchronisation from the taskbar, simply click on the 
program icon on the taskbar, press the right mouse button, and 
select Synchronise from the pop-up menu. 
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Synchronisation Notes: 
• Refer to "The Filters Tab" under "lntellisync Advanced 

Settings Dialogues" for information about filtering records 
for synchronisation. 

• During lntellisync transfers of data between your 
communicator and the Contacts application, pictures 
attached to Contacts cards are ignored. Use PC Suite File 
Transfer commands to transfer .JPG and .BMP files between 
your communicator and PC. 

• Some PC applications have to be running during 
synchronisations. If you are synchronising with one of these 
applications, you may see lntellisync open the application 
during the operation. (Refer to the Supported Systems 
section of on-line Help for information about whether or not 
the system you're using needs to be open or closed during 
data transfers.) 

• Data can be transferred between records in your 
communicator and your PC applications because fields in the 
two systems are "mapped" (linked). lntellisync provides 
default "field mapping," but you may want to alter mapping 
to re-direct (or prevent) the flow of data. Refer to "The Field 
Mapping Dialogue" under "Intellisync Advanced Settings 
Dialogues" for complete information. 

• Once you have synchronised a particular set of data, 
changing field mapping causes the next synchronisation of 
that data to be, in effect, a first-run synchronisation. Refer to 
"Intellisync History Files" and "Synchronisation and History 
Files" in this chapter for an explanation of first-run 
synchronisations. 

• When you synchronise a Nokia 9110 Communicator 
application, it is automatically synchronised with all sections 
in the selected PC application that are compatible with that 
application. 

• For information about how to perform synchronisations 
remotely, see "Remote Synchronisation" under "Intellisync 
Special Topics." 
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lntellisync Advanced Settings Dialogues 

Refer to the Quick Start 
Tutorial for information 
on the lntellisync 
Configuration and 
Choose Translator 
dialogues. 

Clicking the OK button 
in this dialogue saves 
the current setting and 
exits the dialogue. 
Clicking Apply saves 
without exiting. 
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When you run a synchronisation, the operation is affected by 
settings contained in a set of Intellisync "Advanced Settings" 
dialogues. This section describes these dialogues. 

Topics include: 

+ Advanced Settings Tabs 

+ The Field Mapping Dialogue 

Advanced Settings Tabs 
When you click the Advanced button in the Intellisync 
Configuration dialogue, the tabbed Advanced Settings dialogue 
for the selected Nokia 9110 Communicator application appears. 

Transfer Alllichedufed items 

r. !li~~i:~~r::QntYJY~iJ:~~:n:~:ri:.:~ 

Da~• Jlrior to tod•J' 

!l.a~s after toda~ 
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If a setting doesn't apply 
to the Nokia 9110 
Communicator 
application currently 
selected in the 
Configuration dialogue, it 
is not presented. For 
example, when the 
Contacts application is 
selected, neither the Date 
Range nor the To-do List 
tabs are displayed. 

Intellisync 

The tabs in this dialogue contains the following settings and 
features: 

+ Date Range: Determines the range of Date Book items to be 
included in the operation. 

+ To-do List: Determines if all To-do items, or only pending 
To-do items will be included in the operation. 

+ Confirmation: Determines when and if a confirmation 
prompt will appear before a synchronisation takes place. 

+ Conflict Resolution: Determines how data conflicts will be 
resolved if they are detected during a synchronisation. 

+ Filters: Lets you create filters that exclude some records 
from synchronisation (or import/export). 

The Date Range Tab 

The Date Range setting in this tab determines the range of 
Calendar items that will be included in a data transfer. 

dvanced Settings for Calendar 

Date Range Cor,firm.atiot11 Conflict Resolution 

You may choose to restrict the number of appointments or to 
future items only. or restrict to items that fall within a set range 
Appointments outside of range will be removed from the device. 

Option•~------------------, 

r Transfer Alll!cheduled items 

r. !Iiiiitiif~[:i;itiiY:f!:iEY:i~IE~m~ 

Transfer items within a range e>f llal'S 

Days Qrior to today 

!lays after today 

OK 
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You are presented with three options in this dialogue: 

+ Transfer All Scheduled Items: Transfers all dated items. 

+ Transfer Only Future Items: Transfers only future items. 

+ Transfer Items Within a Range of Days: Transfers items 
within a specified number of days before and after "today." 

... To select an option, click on the radio button next to the one 
you want. 

... If you select the Transfer items with a Range of Days 
option, enter numbers in the boxes labelled Days prior to 
today and Days after today. 

Notes: 

• The "Range of Days" option allows you to create a relative 
date range that automatically moves with time. For 
example, if you have selected the range 30 days prior to 
today, and 30 days after today, the two month range 
adjusts itself automatically. That is, as today moves 
forward in time, so does the relative date range. 

• When you mn a synchronisation, records that were 
included in the previous synchronisation will be 
synchronised whether or not they fall within the currently 
specified date range. (Intellisync identifies these items by 
looking at the history file for the previous synchronisation). 
Note, however, that only those items that fall within the 
currently specified date range will be included in the 
update ofthe history file (and therefore synchronised 
during the next synchronisation of the data). 
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Transfer All Items is 
the default setting at 
installation. 

Intellisync 

The To-do List Tab 
The To-do setting in this tab determines whether all To-do list 
items or only pending To-do list items will be included in an 
operation. 

Advanced Settings for To-do list 13 

T o·do list I Conllict FlesrJiution I 

You may choose to restrict the number of items tran~ferred to pending or incomplete 
items onl;o. or choose to transfer all item•. The default i• to transfer all items. 

OK 

... If you select Transfer All Items, all To-do list items, 
including those marked "completed," will be included in the 
operation. 

... If you select Transfer only Pending Items, To-do list 
items that are marked "completed" will not be included in 
the operation. 
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Confirmation prompts 
are only displayed 
during 
synchronisations. 
They do not appear 
during lntellisync 
imports or exports of 
data. 

At installation, both 
options are 
selected. 

Un-checking Confirm 
Record Deletions is 
not recommended. 
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The Confirmation Tab 

Before the results of a synchronisation are applied, you may be 
prompted to confirm the operation. The confirmation prompt­
which lets you proceed with or cancel the operation, display 
details about what will occur, or execute a "full re­
synchronisation"-is a safeguard against accidentally 
modifying or deleting the wrong data. 

The setting in the Confirmation tab determines the conditions 
under which a confirmation dialogue appears. 

Advanced Settings for Calendar 13 

Date Range Confirmation Conflict R e•olution I 
You may request to receive a confirmation dialog just before _your application records 
are actually •ynchronized. T hi:s dialog will inform you of the number of record 
deletions and/or changes al:lout to be applied and will allow you to cancel or 
proceed. 

Options---------------------, 

P" l~~~iil~iX~~~i~.li:~i~ii.~6fJie.~ii.~.~e..n..~i.e.~J 
P" Confirm record J;;hanges (recommended) 

Two options are presented: Confirm Record Deletions and 
Confirm Record Changes. 

Either, both, or neither can be selected. 
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A separate 
co nfi rmatio n 
prompt is displayed 
for each Nokia 
9110 
Communicator 
application you are 
synchronising. 

Intellisync 

... When Confirm Record Deletions is checked, the prompt 
appears if a synchronisation will result in the deletion of 
records. 

... When Confirm Record Changes is checked, the prompt 
appears any time a synchronisation will add or change 
records. 

... If neither of these options is checked, a confirmation prompt 
will only appear if the operation will result in the deletion of 
all records from a system. 

This is a typical confirmation prompt: 

Confirm Calendar Changes f3 

Press Accept tCI let .all changes be made> Clr press Cancel tCI .a¥oid making 
any changes at this time. Press Details to see more information. 

The following changes from Nokia 9110 Calendar will be 
applied tCI your App!:!intments data 1n M S Schedule+ 7. Oa: 

18Additionhl 

The following chanQes from MS Schedule+ 7.0aAppointments will be 
applied tCI your Nokia 9110 Calendar. 

55 Addition( s l 
1 Change(sJ 

Note the five buttons at the bottom of the Confirmation 
prompt: 

• Accept: Accepts the set of changes shown and continues the 
synchronisation. 

• Cancel: Cancels the synchronisation. 
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Refer to "Full Re­
Synchronisation" in 
"lntellisync Special 
Topics" for information 
on full re-
synch ron isation. 
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• Details: Displays a "Details" dialogue box showing a 
detailed description of what will occur if the synchronisation 
proceeds. 

• Re-sync: Performs a full re-synchronisation-in effect, a 
"first -run" synchronisation. 

• Help: Opens the Intellisync on-line Help system. 

The Details Dialogue 
The confirmation prompt that may appear before a 
synchronisation takes place contains a Details button. Use this 
button when you want to review the exact actions that will 
occur if the synchronisation proceeds. 

-·:Details for Confnm Calendar Changes -~13 

D ouoledck any operation to see more details. 

The following will be applied to Lotus Organizer 

Add this is a... 212719 8 

The following will be applied to Nokia 911 0 Communicator. 

The Details dialogue contains a field-by-field representation of 
each of the records that will be affected by the synchronisation 
and, for each, notes the operation that will take place (Add, 
Change, Delete). 
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Note that both the 
original and the new 
values are represented 
in this dialogue. 

Intellisync 

If changes will occur in both of your applications, a separate 
area of the dialogue will be shown for each. 

The operation that will take place for each record is indicated in 
the first column of the Details dialogue. 

To see rmre details about any single record, double click on the 
operation for that record. This displays an "Additional Details" 
dialogue. 

The following record will l>e changed in Nokia 811 0 Communicator 

Field Former value Value 
Start dale var1es var1es 
Start lime 8:30AM 830AM 
Finish 9:30AM 9:30AM 

! Alarm 0 
AlarmFiag No No 
Te'l NOK18 NOK18 
Repeals Weekly Weekly 
First Dale 1/18/00 1/18/00 
Last Dale Open-ended Open-ended 

! Excluded Dales None 2/28/00 

Notes: 

• Details dialogues can be resized. When you resize a 
dialogue, the position and size is remembered the next time 
you display a Details dialogue. 

• Data in "Additional Details" dialogues can be sorted, in 
either ascending or descending order, by double clicking on 
the column heading (clicking the same column heading 
again sorts the column in the opposite order). 

• To see the full contents of a field whose value is truncated 
in the Additional Details dialogue, double click on the field 
name. For a changed item, both the former and new values 
are displayed. 
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To specify a Conflict 
Resolution setting, 
select the radio button 
next to the option you 
want. 

Notify me when 
conflicts occur is the 
default setting. 
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The Conflict Resolution Tab 

When a data conflict occurs during a data transfer, and 
Intellisync can't resolve it using the normal synchronisation 
process, the Conflict Resolution setting selected in this tab is 
used to resolve it. 

Advanced Settmgs for Calendar 13 

Date; Rat1ge I Confirmation Conflict R .e•olution I 
Select the action to be taken when changes made to a data item in Nokia 911 0 
Communicator conflict with changes made to the same item in Lotus Organizer 97. 
The default is to notifl' J'OU when conflicts occur. 

Options~------------------, 

Ajjd all conflicting item~ 

OK 

!gnore all conflicting items 

Nokia 911 0 Communicator lltin~ 

Lotus Organizer 97 Win£; 

What is a Data Conflict? 

Help Field Mapping ... 

A data conflict exists when records in your two systems that 
should be equivalent contain conflicting data in one or more 
mapped fields. 

More specifically, a data conflict exists when two records 
contain the same key field values, but different values in other 
mapped fields. 
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Refer to "Field 
Mapping and 
Freeform Fields" 
under "The Field 
Mapping Dialogue" 
for information on 
how lntellisync 
interprets your 
communicator's 
Name field. 

Refer to 
"Synchronisation 
and History Files" 
under "lntellisync 
Special Topics" for 
information on first­
run 
synchronisations. 
See "Full Re­
Synchronisation" in 
lntellisync Special 
Topics for details 
on full re­
synchronisation. 

Intellisync 

Key Fields 

Fields designated as "key" are those that are the most 
fundamental to a particular record. For example, First Name 
and Last Name fields are key fields in Contacts records. 

The use of key fields in detectin2 data conflicts is premised 
on the following: When key fields in a Nokia record match the 
key fields in a PC application record, other mapped fields in the 
two records should also match. In other words, if both of your 
systems have an address record for Ron Ogg, the values in 
Title, Company, etc. should match. If they do not, a data 
conflict exists. 

Note: Letter case counts in key fields. If you have a record for 
Diana VanW nkle in your PC application, and one for Diana 
Vanwinkle in your communicator, Intellisync does not recognise 
the names (or, therefore, the records) as equivalent 
Synchronisation causes both records to occur in each system. 

See Key Fields in on-line Help for information about which 
fields are key fields for each data type. 

The occasions when the Conflict Resolution setting is needed to 
resolve data conflicts are as follows: 

+ First-run and full-re-synchronisations. 

+ Imports and Exports of data. 

+ When new records have been added to each system since the 
last synchronisation, and those records conflict. (For 
example, if you have added an address record for Brian 
Sawyer to each of your systems, but the Company fields 
don't match.) 

+ When mapped fields have been edited in both systems since 
the last synchronisation, but edited differently. (For example, 
if you have updated Brian's home phone number in both 
records, but made a typographical error in one of them.) 
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Notify me when 
conflicts occur is the 
default setting. 

See "The Conflict 
Resolution Dialogue 
Box," below, for 
more information 
about the Notify 
setting. 

Note the check box 
labelled "Apply to all 
conflicts." If you 
check this box, the 
action you choose in 
this dialogue will be 
automatically applied 
to any other conflicts 
detected for the 
current Nokia 9110 
Communicator 
application. 
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Conflict Resolution options work as follows: 

+ Add all conflicting items: Adds a new record to each 
system (or, for one-way transfers, to the target system). The 
original conflicting records remain intact. 

+ Ignore all conflicting items: Makes no change to either 
system. 

+ Notify me when conflicts occur: Displays a dialogue box 
each time a data conflict occurs, letting you decide which 
data to use on a case-by-case basis. 

+ Nokia 9110 Communicator Wins: Uses data from your 
communicator when conflicts occur. Use this option when 
your communicator contains the most current information. 

+ Other Application Wins: Uses PC data when conflicts 
occur. Use this option when your PC application contains 
the most current information. 

The Conflict Resolution Dialogue Box 

When Notify is the Conflict Resolution setting, a dialogue is 
presented each time Intellisync needs help resolving a conflict. 

Conflict Re•oluhon (Calendar) 13 

Item: 

Field Name II MS Outlook 97 II Nokia 911 0 Communicator I 
~ Alarm 30 

I I 
I I 
I I 
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The Conflict Resolution dialogue shows the conflicting fields 
from both systems. The field name is displayed in the left 
colunm. The PC application's field value is in the centre, and 
the Nokia 9110 Communicator application's field value is on 
the right. 

A box at the top labelled "Item" contains a key field value. 
This helps to identify the conflicting record. 

If a record in one system conflicts with more than one record in 
the other system, the box to the right of the Item box will say 1 
of 2, or 1 of 3, (etc.), and left and right arrow controls will let 
you switch between conflicts. 

To resolve a conflict in the Conflict Resolution dialogue box, 
you can select one of the following options from the list box 
below the grid: Add, Ignore, Update, or Replace (Import/Export 
only). 

+ Add: Adds a new record to each system (or, for one-way 
data transfers, to the target system). The original 
conflicting records remain intact. 

+ Ignore: Makes no change to either record. 

+ Replace: (Import/Export only) Replaces the target record 
with a record containing mapped values from the source 
record. Unmapped fields in the original record will be lost. 

+ Update: Updates one or both records (as necessary) with 
the value or values you have highlighted in the grid. Use 
Update instead of Replace to avoid losing un-mapped fields 
in the target record. 

Conflict Resolution Dialogue Buttons 

The Conflict Resolution dialogue box also contains the following 
four buttons: 

• OK: Initiates the specified action and continues the 
operation. 

• Stop: Takes no action and terminates the operation. 
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• View: Displays a dialogue showing the full contents of the 
selected field. Use this to display complete values when 
lengthy values are truncated in the Conflict Resolution 
dialogue box. 

• Help: Displays on-line Help text. 

Conflict Resolution Notes: 

• Refer to "The Same Record Changed and Deleted 
Dialogue" under "Intellisync Special Topics" for 
information about a special Conflict Resolution dialogue 
that appears when a record has been deleted in one system 
and changed in the other system since the last 
synchronisation. 

• Remember: Except for "first-run" synchronisations, the 
Conflict Resolution setting is not normally needed to 
resolve conflicts when you're synchronising your two 
systems. In most cases, Intellisync knows how to edit 
records to achieve synchronisation. 

• Conflict Resolution is applied individually to each pair of 
configured applications. This means that any time you 
change the Conflict Resolution setting, the change will 
apply only to the currently selected applications. 

• Since "Notify" (the default) is the only setting that lets you 
see each data conflict and decide for yourself how the 
conflict should be resolved, it is the recommended setting. 

Verizon Wireless 
Exhibit 1035-0062 



The names of the filters 
you create are shown in 
the Filters tab. 

A pre-existing filter, 
Exclude Private Data, 
lets you exclude records 
marked Confidential, or 
Private, etc. 

To activate a filter for 
use, click on it (you can 
only use one at a time.) 
Click <None Selected> if 
you do not want to apply 
a filter to the next 
synchronisation. 

Intellisync 

The Filters Tab 

The Filters tab of the Advanced Settings dialogue lets you "filter" 
records for synchronisation, import, or export. 

Advanced Settings for Contacts 13 

Filt"• 

Lotus Organizer GS PIM Address Filters· 

0 <None Selected> 
0 Exclude Private Data 

F1lter1 
0 Filter2 

By default all records in the applications you configure for 
synchronisation are included when you run an Intellisync 
operation (unless they are excluded by the Date Range or To-do 
list setting). 

If you want to synchronise (or import/export) only a subset of 
items, you can filter records using Intellisync's filtering 
function. 

For example, the following filter instructs Intellisync to include 
only address records that have a Last Name value starting with 
A through M, and have the Company value of Bankers Ltd. 

Last Name is between A and M AND 

Company equals Bankers Ltd. 
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When you click New, 
you are prompted to 
name the filter before 
creating it. 
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Filters Tab Commands 

The Filters tab contains the following command buttons: 

• The New button is used to create a new filter for the 
currently selected communicator and PC applications. 

• The Edit button lets you edit an existing filter. 

• The Rename button lets you rename an existing filter. 

• The Delete button deletes the highlighted filter. 

Conditions and Rules Tabs 

Clicking the New or Edit button in the Filters tab displays two 
additional tabs: Conditions and Rules. 

The Conditions Tab 

The Conditions tab is where you specify the condition(s) that a 
record must meet in order to be included in a data transfer. Each 
condition consists of a Field, an Operator, and a Value. 

For example, here are some conditions that could be applied to 
various applications: 

Field Operator 

Last Name is between 
Company equals 
Title equals 
Date is between 
Start Date on or after 

Value(s) 

AandG 

Global Air 

President 

01/01/1998 and 07/01/1998 

01/07/98 
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The Rules Tab 

The Rules tab contains options corresponding to the logical 
operators AND and OR. 

All Conditions must be met = AND 

One or more conditions must be met = OR 

Select an option in the Rules tab when you want to include more 
than one condition in a filter. 

Note: Only one logical operator can be applied to any given 
filter. You cannot create filters that contain both AND and OR. 

By combining conditions with a logical operator selected from 
the Rules tab, you can create filters like the following: 

Date after 11/06/97 AND 
Time after 14:00 

Company equals Bankers Ltd. OR 

Company equals Global Air OR 

Company equals Software House Ltd. 

The first filter would include only records with date values after 
11/15/97 and time values after 14:00. (Note that times are shown 
in 24-hour format-e.g., 14:00 for 2 p.m.) 

The second filter would include only records with a Company 
value of Bankers Ltd., Global Air, or Slftware House Ltd. 
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If you want to change 
the Operator or Value 
entry for a condition in 
this dialogue, change 
the entry and click 
Update. Clicking 
Remove deletes the 
highlighted condition. 
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Creating a F i Iter 
Follow these steps to create a filter: 

1. Click the New button in the Filters tab. When prompted for 
a filter name, type a name and then click OK. This displays 
the Conditions dialogue. 

Conditions Rules 

Add a new finer condition to the list or Update the currentlY selected filter conditicn 
(highlighted in the li•t box below). OnlY item• passing the conditions below will be 
transferred. 

I field ..... I Operator: Value: 
II Business City I equals .!JINashua 

{lddlo List I f!emove 

Last Name is between 'A' AND 'M' AND 

[Business Zip] equals '03062' 

I OK I Cancel I Help I 

2. Click the Field button to display the field list for the selected 
PC application. Highlight the field you want to filter on. 
This places it in the Field text box. 

3. Select an operator for the condition by highlighting an 
option in the Operator list box. (See below for the list of 
operators you can choose from.) 

4. Enter a value or values in the Value text box to complete the 
condition. Then click the Add to List button to place the 
condition in the Conditions List in the lower part of the 
dialogue. 
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Note that a logical 
operator will not 
appear in the 
Conditions tab until 
a second condition is 
added. 

The Boolean operators 
is true and is false 
are used for fields like 
Completed? and 
Confidential? that are 
either checked or 
unchecked. 

is true = checked 

is false = unchecked 

Intellisync 

5. To add other conditions to the filter, click the Rules tab and 
select All Conditions must be met (AND) or One or more 
conditions must be met (OR). Then click the Conditions tab 
and specify additional conditions. 

6. When the filter is complete, click OK to save it. 

Conditions Tab Operators 
There are four operator types that may be offered in the 
Conditions tab: String, Date, Time, and Boolean. Choices 
available for each type are as follows: 

String Date 
starts with equals 
contains does not equal 
does not contain after 
equals before 
does not equal on or after 
is empty on or before 
is not empty is between 
is between today minus 7 

days 
today plus 7 
days 

Time Boolean 
equals is true 
does not equal is false 
after 
before 
on or after 
on or before 
is between 
nowmmus 
7 minutes 
now plus 7 
minutes 

Page 59 

Verizon Wireless 
Exhibit 1 035-0067 



PC Suite for Nokia 9110 Communicator 

Page 60 

Filtering Notes: 

• Filtering can be applied to Intellisync imports and exports as 
well as synchronisations. 

• If you filter on a field that is not mapped, Intellisync can 
filter on the PC side, but not on the communicator side. In 
other words, records will be excluded from your PC 
application, but not from your communicator. 

• If you filter on a field that is contained in only one of your 
systems, the filter will only exclude records in that system. 

• You cannot use both AND and OR in a single filter. 
However, you can use the operator is between to create 
conditions like Last Name is between A and C. This, in 
effect, says "If Last Name starts with A, or Last Name starts 
with B, or Last Name starts with C." You can then use the 
AND operator to create a filter like the following which, in 
effect, does utilise both logical operators. 

Last Name is between A and C AND 
Company equals Kennel Ltd. 

• If you change or select a different filter after you've run a 
synchronisation with Outlook, the next synchronisation will 
be, in effect, a first-run synchronisation. 

• A filter only applies to the Nokia 9110 Communicator and 
PC applications that were selected in the Configuration 
dialogue when the filter was created-e.g., Address Book, 
To Do List, etc. Filters must be created separately for each 
set of applications you want to synchronise. 

• Clicking on a filter name in the Filters tab activates that 
filter for the next synchronisation. (Only one can be selected 
at a time.) When a filter is active, its name appears in the 
bottom right comer of the Configuration dialogue when the 
application to which it applies is highlighted. 

• Click <None Selected> in the Filters tab if you do not want 
to apply a filter you've created to the next synchronisation. 
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Use the Section 
drop-down list box 
to specify the 
section for which 
you want to display 
field mapping. 

Intellisync 

The Field Mapping Dialogue 
In order for data to be transferred between your connnunicator 
and your PC application file, corresponding fields in each 
application must be linked to one another, or "mapped." 
Intellisync provides default "field mapping," which links 
equivalent fields in your two systems. But you can edit mapping 
to re-direct (or prevent) the flow of data as needed . 

... To access field mapping for selected applications, click the 
Field Mapping button at the bottom of the Advanced 
Settings dialogue. This displays the Intellisync Field 
Mapping dialogue. 

Field hlapprng l01 Calendar 113 

Drag the fields in the right column up or down to align them with matching Nokia 9110 
Communicator fields in the left column. Double-click or press the spacebar to map or 
unmap the fields. Check that all desired fields are mapped. 

Nokia 911 0 Communicator 

Startdate-++- Date 

Start time Descupt1on"" 

Finish date Categories 

Finish Occurs every .vear? 

Alarm-++-Aiarm Time 

AlarmFiag-++- DisplaJI Alarm? 

T ""' Confidential? 
Te:-:t- First Line~ Description - First Line 

Te"t- Rest of-++- Description- Rest of IF 

The Field Mapping dialogue lists communicator fields on the 
left, and PC application fields on the right. Bi-directional 
arrows appear between fields that are "mapped," or linked, for 
synchronisation. 
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... To un-map mapped fields: Click on the arrow (or highlight 
the PC field name and double click or press the Spacebar). 

... To map adjacent fields: Click between the fields (or 
highlight the PC application field name and double click or 
press the Spacebar). An arrow appears to indicate that the 
fields are mapped. 

... To map non-adjacent fields: Drag the field in the right­
hand column and drop it next to the field in the left-hand 
colunm. 

... To reinstate default field mapping: Click the Reset 
button. 

Field Mapping Dialogue Buttons 

The buttons at the bottom of the Field Mapping dialogue work as 
follows: 

• OK: Saves changes made to field mapping and re-displays 
the previous Advanced Settings dialogue. 

• Cancel: Cancels changes made to field mapping. 

• Help: Opens the Intellisync on-line Help system. 

• Reset: Resets field mapping to the installation default 
configuration. 
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Field Mapping Notes: 

• lntellisync enforces certain field mapping rules. For 
example, you cannot map date fields to ti rre fields. If you 
attempt to map incompatible field types, an error message 
is displayed. 

• If you change field mapping after data has been 
synchronised, the subsequent synchronisation will be, in 
effect, a first-run synchronisation. 

• Fields marked with asterisks in the Field Mapping 
dialogue are fields that must be mapped (or their sub-fields 
must be mapped) in order for a data transfer to succeed. If 
marked fields are not mapped, an error message is 
displayed when you attempt to exit the Field Mapping 
dialogue. 

• Check the Supported Systems on-line Help topic for the PC 
application(s) you're using to see if any special field 
mapping rules apply. (For example, if your application 
allows for the creation of custom fields, the Help topic for 
that system should tell you how to map custom fields.) 

• When a data string is transferred between fields in your 
communicator and your PC application, it may be 
truncated in the target field if it is too lengthy to be 
accommodated. It is not wise to edit truncated data. If you 
do, the data in the other system will be truncated after the 
next synchronisation. Refer to "Synchronisation and Data 
Truncation" under "lntellisync Special Topics" for a 
workaround that allows you to edit truncated text. 
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If your freeform 
fields are formatted 
inconsistently, 
synch ron isations 
and exports will 
result in the incorrect 
placement of values 
in your PC 
application. 

Select the address 
format that most 
closely resembles the 
one you're using. 
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Field Mapping and Freeform Fields 

When Intellisync transfers Name and Address fields between 
your two systems, it assumes a particular format for your 
communicator's Name and Address fields. 

The default Name format is as follows: 

LAST, FIRST MIDDLE 

The Address format is determined by the Address Format you 
select when you first configure an operation. (Refer to 
"Intellisync Address Formats" under "Intellisync Special 
Topics" for a description of each of the four available formats.) 

If names are not entered into your communicator in the above 
format, and/or if the addresses in your communicator's 
Contacts application do not match any of the available formats, 
you may want to adjust the field mapping in the Field Mapping 
dialogue to direct values between the correct fields. 

For example, if the third line in your addresses is formatted in 
this way: City, State, Postal Code, but the selected Address 
format is Postal Code, City, State, the following field mapping 
scheme would transfer values correctly between your 
communicator and PC: 

Communicator 

City ~ 

State ~ 

Postal Code ~ 

PC Atmlication 

Postal code 

City 

State 
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lntellisync Special Topics 
This section is devoted to explaining in detail some aspects of Intellisync 
that have only been touched upon in previous sections of this chapter. 

Topics include: 

+ Synchronisation and History Files 

+ Intellisync Terms 

+ Intellisync Address Formats 

+ Importing and Exporting Data 

+ Synchronisation and Truncated Data 

+ Full Re-Synchronisation 

+ The Same Record Changed and Deleted Dialogue 

+ Sync Log Files 

+ Remote Synchronisation 
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An understanding of 
history files and how 
synchronisation 
works is not 
mandatory. 
However, you may 
find this information 
helpful. 

See "The Conflict 
Resolution Tab" 
under" lntellisync 
Advanced Settings 
Dialogues" for details 
on Conflict 
Resolution. 

For additional 
information about 
history files, refer to 
the lntellisync on-line 
Help system. 
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Synchronisation and History Files 
During a synchronisation, Intellisync compares records in your 
communicator application to records in your PC application, 
and makes whatever changes are necessary in each system to 
ensure that both contain the same information. 

If a record has been added to one system and not the other, that 
record is added to the incomplete system. If a record has been 
deleted from one system and not the other, Intellisync deletes 
the record from the other system. If there are discrepancies 
between records in the two systems, Intellisync uses the most 
current data. It knows which is the most current because it uses 
a "history file" when comparing the records. 

The first time a particular set of data is synchronised, there is 
no history file. Data from the two applications are simply 
merged, and conflicts between the two systems are resolved 
using a "Conflict Resolution" setting. 

However, this initial operation creates the history file that will 
be used for subsequent synchronisations. 

How does the history file work? At the end of each 
synchronisation, a history file matching the two synchronised 
systems is created. When the systems are next synchronised, 
Intellisync compares the two synchronised systems to each 
other, and to the history file. If a record in the history file 
matches one system, but not the other, Intellisync knows that 
the "conflicting" record has been changed since the last 
synchronisation. It therefore applies the change to the other 
system and to the history file. 

In cases where changes have been applied to both systems, and 
those changes conflict (for example, if you have added address 
records for the same name to each system, but the phone 
numbers don't match), the Conflict Resolution setting is used to 
resolve the matter. 
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If address data in your 
communicator is not 
consistently formatted, 
and you have the same 
basic data in your PC 
application, you can 
achieve consistency by 
deleting the addresses 
from your 
communicator and 
synchronising with your 
PC application. This will 
transfer the contents of 
your PC application 
back into your 
communicator in the 
selected Address 
Format. 
Before doing this, 
however, it would be 
wise to backup your 
communicator data as 
a precaution. 

Intellisync 

lntellisync Address Formats 
In order for Intellisync to transfer data correctly between your 
connnunicator and your PC application, it must assume a 
particular format for freeform Name and Address fields in your 
connnunicator's Contacts application. 

Intellisync assumes that Name fields are entered into your 
communicator as follows: 

Last, First Middle 

When you first configure an Intellisync operation for a 
particular connnunicator, you are prompted to select an 
Address format. Address formats can also be accessed by 
selecting Contacts on the Intellisync Options menu. 

Intellisync offers five formats to choose from-Address Format 
1, Address Format 2, and so on. If none of the formats match 
the format you are using, you can either select the closest 
format and adjust field mapping to account for the differences, 
or choose Format 5, which transfers the communicator's 
complete Address field to a single field in your PC application. 

Refer to "Field Mapping and Freeform Fields" under 
"Intellisync Advanced Settings Dialogues" for additional 
information on freeform Name and Address fields. 

Note: In order for Intellisync to successfully transfer data 
between your two systems, data in freeform fields must be 
entered in a consistent format. If your freeform fields have been 
entered inconsistently, the results of a synchronisation, import, 
or export will reflect that inconsistency. 
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Avai I able Address For mats 

Address Format 1 

Address Item 1, City, State, Postal Code, Country 

For example: 13 Lewis St., Moose Junction, MO, 45678, USA 
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Address Format 2 

Address Item 1 <newline> 

City, State, Postal Code, Country 

For example: 1312 Lewis St. 
Moose Junction, MO, 45678, USA 

Address Format 3 

Address Line 1 <newline> 

Address Line 2 <newline> 

City, State Postal Code <newline> 

Country 

For example: 1312 Lewis St. 
Suite 34 
Moose Junction, MO 45678 
USA 
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Address Format 4 

Address Line 1 <newline> 

Address Line 2 <newline> 

Postal Code, City, State <newline> 

Country 

For example: 1312 Lewis St. 
Suite 34 
45678, Moose Junction, MO 
USA 

Address Format 5 

Intellisync 

Selecting Address Format 5 is, in effect, selecting no format. 
This option can be used if you have not used consistent 
formatting in your communicator, or if none of the other 
formats resemble the format you're using. 

When you select Address Format 5, your communicator's 
multi-line Address field is transferred to a single field in your 
PC application, and vice versa. Check the Field Mapping 
dialogue to see the default mapping. 

Note: Using this format during synchronisations may result in 
the transfer of incomplete addresses from your PC application 
to your communicator. 

For example, when Address Format 5 is selected, Intellisync 
maps the communicator's Address field to the Address portion 
of a Schedule+ address. (A complete Schedule+ address 
includes Address, City, Sate, Postal Code, and Country.) Thus, 
only the Address portion of a Schedule+ address transfers to 
your Nokia 9110 Communicator. City, Sate, etc. are ignored. 
In order to transfer the entire Schedule+ address to your 
communicator, you would need to enter the entire address into 
the Address field. 
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Importing and Exporting Data 
In addition to synchronising your communicator with PC 
applications, Intellisync can also perform imports and exports of 
data from one system to the other. 

The same procedures that are involved in configuring and 
performing a synchronisation are used for importing and 
exporting. That is, you have to set up the Configuration and 
Choose Translator dialogues, and, if necessary, adjust settings in 
the Advanced Settings, Options, and Field Mapping dialogues. 
Once things are set up, the Synchronise button on the Intellisync 
opening screen initiates the operation. The only difference is in 
the choice of the operation in the Choose Translator dialogue. 

rOQeratior. 

(: !mport ~r.chror.ize I 

+ To import data from your PC to your communicator, select 
Import. 

+ To export data to your PC from your communicator, select 
Export. 

Notes: 

• When you perform an import or export, lntellisync doesn't 
duplicate records that already exist in both systems. For 
example, if you export the contents your communicator's 
Contacts application to your PC, records that are already 
contained in both systems are not transferred to the PC file. 

• In a single operation, you can perform different types of data 
transfers. For example, in one operation, you can import into 
your communicator's Contacts application, export Calendar 
information, and synchronise your To Do's.lt's simply a 
matter of which operation you choose for each set of data. 
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Synchronisation and Data 
Truncation 

Intellisync 

When data is transferred between fields in your communicator 
and your PC application, data is truncated in the target field if 
the source data is too lengthy to be accommodated. 

If you later edit the truncated data, the corresponding data in 
your other system is truncated after the next synchronisation. 
(Because Intellisync applies the detected edit to the data.) 

If you want to edit truncated data, there is a workaround-as 
follows: 

Any time you edit truncated data, go in and edit the 
corresponding record in the other system. (It can be the same 
change you made in the shortened record, or a trivial edit of no 
consequence. The important thing is that a change is registered 
in that record). Make sure the "Notify" Conflict Resolution 
setting is selected. Then, during the next synchronisation, when 
the Conflict Resolution dialogue box is displayed for that 
record, select Ignore. This prevents the truncated data from 
overwriting the data in your other system. 

Note: If you select Ignore, as recommended, you will be 
prompted to resolve the conflict again the next time you run a 
synchronisation. If this is not acceptable, you can highlight the 
original (non-truncated) text in the Conflict Resolution 
dialogue and choose Update. Note, however, that this will 
overwrite the edit that caused the conflict in the first place. 
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Refer to "The 
Confirmation Tab" 
under" lntellisync 
Advanced Settings 
Dialogues" for 
information on the 
confirmation prompt. 
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Full Re-Synchronisation 
If, for some reason, the data in either your communicator or 
your PC application is lost or unintentionally altered, do not 
synchronise the data. Doing so will transfer the problem to your 
other system. 

For example, if all address records were accidentally deleted 
from your PC application, Intellisync would see that all the 
records were deleted since the last synchronisation and remove 
the address records from your communicator. 

Fortunately, the confirmation prompt would warn you before 
such a synchronisation actually took place. In addition to 
warning you, it would allow you to use the Re-Sync button to 
execute a Full Re-Synchronisation. 

Unlike a normal synchronisation, a full re-synchronisation 
would not delete the records in your communicator. This is 
because a full re-synchronisation is, in effect, a "first-run" 
synchronisation. That is, the history file is thrown out, and the 
synchronisation simply merges the contents of the two systems. 

Notes: 

• If the data in your communicator or PC application is not 
lost, but has in some other way been corrupted, you can 
delete the contents of the file and execute a full re­
synchronisation to transfer the contents of the other system 
into the empty file or application. Note, however, that only 
mapped values can be transferred to the empty system. 
Unmapped values will be lost from any records you delete. 

• The confirmation prompt is the only way to access theRe­
Sync button. It is therefore advisable to keep active the 
Confirm Record Deletions setting in the Advanced 
Settings dialogue. 
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This dialogue 
appears only when 
Notify me when 
conflicts occur is 
the selected Conflict 
Resolution setting. If 
any other setting is 
selected, a change 
will always override a 
delete-that is, the 
changed record will 
be added to the 
system from which 
the record was 
deleted. 

Intellisync 

The Same Record Changed and 
Deleted Dialogue 
If, during a synchronisation, Intellisync discovers that a 
previously synchronised record has been changed in one system 
and deleted in the other since the last synchronisation, a 
special dialogue is displayed. 

OK 

The Same Record Changed and Deleted dialogue alerts you to 
the deletion of the record in one system, and shows you the 
record as it has been changed in the other. A list of options 
allows you to decide between the following actions: 

+ Add: Adds the item back into the system from which it was 
deleted. 

+ Delete: Deletes the record from the other system. 

+ Ignore: Lets each system remain as it is. 
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The Sync Log file can be 
a good source of 
information if you call for 
technical assistance. 

The Sync Log file is a 
simple text file that can 
be viewed using any 
editor. 

Each time you run a 
synchronisation, the file 
is overwritten. If you 
want to save a particular 
Sync Log file, rename 
the file before running 
another synchronisation. 
The file is located in a 
sub-directory (of the 
installation directory) 
named after the 
communicator serial 
number. 
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A set of buttons also appear at the bottom of the dialogue. 

• OK: Exits the dialogue and applies the selected action. 

• Stop: Stops the synchronisation. 

• View: Lets you see the complete value of the highlighted 
field when it is too long to be displayed in the grid. 

• Help: Calls on-line Help. 

The Sync Log File 
Intellisync maintains a Sync Log file that is updated after each 
data transfer. The Sync Log file contains a detailed accounting of 
what occurred during the synchronisation, import, or export. 

Normally, it's not necessary to read the Sync Log file after an 
operation. However, if errors were reported, it may be a useful 
source of information. 

To view the Sync Log file for the last data transfer, select the 
Sync Log command on the Intellisync View menu. 

The file identifies the records that were transferred from one 
system to the other, and indicates the exact action that was taken 
for each record. Field Mapping is also shown in the Sync Log 
file. 

Reading a Sync Log File 

Before any actions are taken during a data transfer, records from 
each system are read (looked at). You will see the term READ 
used in the log file to indicate this process. 
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After reading records in each of the systems, Intellisync 
compares the records in both systems, as indicated in a section 
labelled Summary of Data Analysis. Here you will see phrases 
such as: Unchanged on Both Systems, Changed on First System, 
and Deleted from Slcond System 

The next section of the Sync Log file lists the actions that were 
taken in your "First System" (Nokia 9110 Communicator) and 
"Second System" (PC application) during the data transfer. 

Actions that may be noted in the Sync Log file are as follows: 

ADD: The record was added. 

DELETE: The record was deleted. 

FAIL RANGE: The item was excluded from the operation. It 
either failed the Date Range check for Appointments or it was a 
"completed" To-do list item, and the Transfer Only Pending 
Items option was checked in the To-do list tab of the Advanced 
Settings dialogue. 

IGNORE: The record was ignored. 

SKIP: The record was skipped because the data transferred was 
of a different type. 

UPDATE: The record was updated with a value or values from 
the other system. 
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lntellisync lets you 
configure and save both 
a local and a remote 
synchronisation for 
each Nokia 911 0 
Communicator you 
connect and "register." 
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Remote Synchronisation 
Intellisync allows you to configure and run "Remote" as well as 
"Local" synchronisations of Calendar data. A remote 
synchronisation is a synchronisation that you can run remotely, 
over a data call. 

To configure a remote synchronisation, follow the "Quick Start" 
instructions provided at the beginning of this chapter-only click 
the Remote tab to configure the operation. 

Remotevs. Local Synchronisation 
When you run a synchronisation locally, you are sometimes 
prompted for information. For example, if the "Notify" Conflict 
Resolution setting is selected, you may be prompted to resolve 
data conflicts. If your PC application requires a password, you 
will be prompted to enter a password-and so forth. 

Since interaction with your computer is not possible when you 
run a remote synchronisation, remote synchronisations are a little 
different from local ones. 

Please note: 

+ When you configure a remote synchronisation, you will 
notice that the Conflict Resolution tab of the Advanced 
Settings dialogue does not contain the Ignore and Notify 
options. (Add is the default Conflict Resolution setting.) 

+ During a synchronisation, if Intellisync discovers that the 
same record has been deleted in one system and changed in 
the other since the last synchronisation, the change is 
applied instead of the delete. 

+ There is no Confirmation tab in the Advanced Settings 
dialogue because a confirmation prompt does not display 
during remote synchronisations. 

+ You cannot synchronise PC applications that require you to 
type a password for access during a synchronisation. 
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Refer to Chapter 9, 
"Internet," in your Nokia 
9110 Communicator 
manual for information 
on connecting your 
communicator to your 
PC via the Internet. 

Intellisync 

Running a Remote Synchronisation 

In order to run a remote synchronisation, you must have an 
Internet access point to facilitate the remote connection to your 
PC. In addition, PC Suite for Nokia 9110 Communicator must 
be up and running on your PC. 

Once you have configured a remote synchronisation, follow 
these steps to run it from your communicator: 

1. Press the System application button on your 
communicator. 

2. Choose Remote Synchronisation and press Select. 

3. Press Settings and define the destination host (the IP 
address of the server PC) and select your Internet access 
point. 

4. Press Start to start a data call and begin synchronising. 

When the synchronisation is complete, the data call ends. 
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lntellisync Glossary 

Boldfaced text identifies 
additional terms defined 
in this section. 

See "The Conflict 
Resolution Tab" under 
"lntellisync Advanced 
Settings Dialogues" for 
more information about 
Conflict Resolution and 
data conflicts. 
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Read this section to gain an understanding of some of the terms 
that are used to describe PC Suite's Intellisync function. 

Conflict Resolution 

A process (controlled by a setting in the Conflict Resolution tab 
of the Advanced Settings dialogue) that is sometimes used by 
Intellisync to determine how to resolve data conflicts during 
synchronisations. See Data Conflict, below. 

Data Conflict 

A data conflict occurs when records in both systems have 
matching key field values but conflicting data in other mapped 
fields. (For example, if both systems have address records in 
which the First and Last Name values are identical, but the 
address values differ.) 

The very first time a set of data is synchronised (and any time 
you import or export data) the Conflict Resolution setting in the 
Advanced Settings dialogue is used to resolve all such conflicts. 
Upon subsequent synchronisations of the same data (after the 
history file has been created), the Conflict Resolution setting is 
needed only under either of the following two conditions: 

1) When records with the same key fields have been added to 
both systems since the last synchronisation, but they have 
conflicts in other mapped fields. 

2) When mapped fields in previously synchronised records 
(with matching key fields) have been edited since the last 
synchronisation, but edited differently. 
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Fanning 

The conversion of a repeating item into many individual items 
("fanned" items) having unique dates. Fanning occurs when one 
of your systems does not support an incoming repeating item. 

Field Mapping 

The linkage that directs the comparison and transfer of data 
during an Intellisync data transfer. Field mapping is contained 
(and can be edited) in the Intellisync Field Mapping dialogue. 

To access the Field Mapping dialogue, select the Field Mapping 
button in the Advanced Settings dialogue. 

Filter 

A statement that can be applied to a synchronisation to restrict 
the records that are included in an operation. See "The Filters 
Tab" under "Advanced Settings Dialogue" for information 
about using Intellisync filters. 

First-Run Synchronisation 

The first synchronisation of a particular set of data. 

A first-run synchronisation is different from subsequent 
synchronisations of the same set of data because no history file 
exists. The history file is created during the first run (and the 
Conflict Resolution setting is used to settle data conflicts 
between the two systems.) 
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Full Re-Synchronisation 

A special mode of synchronisation that merges rather than 
synchronises data in your two systems. (In effect, a "first-run" 
synchronisation.) This is used for restoring lost data and for 
maintaining data integrity when records have been altered. A full 
re-synchronisation can be performed using the Re-Sync button in 
the confirmation prompt that may appear before the results of a 
synchronisation are applied. Refer to "The Confirmation Tab" 
under "Intellisync Advanced Settings Dialogues" for more 
information. 

History File 

A file that is created by a "first-run" synchronisation and 
updated after every subsequent synchronisation. This file aids 
Intellisync in determining which data to use when there are 
discrepancies between your communicator and PC application. 
See "Synchronisation and History Files" under "Intellisync 
Special Topics" for more complete information. 

Key Field 

A field specially defined to detect data conflicts during a data 
transfer. During a synchronisation, Intellisync compares the 
values of mapped fields in your two systems. When "key" values 
match, but other mapped values differ, a data conflict exists. For 
example, in Contacts records, if Name (key) values match, but 
Phone values differ, this is a data conflict. 

Mapped Fields 

Fields that are linked for data transfer in the Intellisync Field 
Mapping dialogue. 
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Section 

A type, or category, of data contained in a PC application. For 
example, Addresses, Notepad, and &;hedul e are sections 
contained in some of the PC applications supported by 
Intellisync. 

Synchronisation 

The Intellisync operation that compares the records in your 
communicator to the records in a PC application file, and makes 
whatever changes are necessary in either system to make sure 
that they both contain the same data. 

Translator 

A component of the Intellisync software that enables Intellisync 
to transfer data between your Nokia 9110 Communicator and a 
particular PC application. 
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lntellisync Menu Commands 

I FILE 
Ex1t I Exits PC &lite. 

VIEW 

Status Bar Toggles status bar on and off. 

Sync Log Displays the Sjnc Log for the I ast 
I ntell i sync operation. 

COMPONENTS 

Contacts S:arts Contacts application corrponent. 

Intellisync Accesf:l25 I ntell i sync corrponent. 

File Transfer Accesf:l25 File Transfer component. 

Backup/Restore Accesf:l25 Backup/Restore corrponent. 

Install/Remove Accesf:l25 I nstall /Remove corrponent. 

Import/Export Accesf:l25 I rrport/Export corrponent. 

OPTIONS 

Contacts Displays Contacts Address Forrrat and 
File options. 

Desk Stand Button Displays desk stand button options. 
Settings 

Registered Lists the communicators that have 
Communicators been connected and named. 

Preferences Displays the Preferences dialogue. 
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HELP 

Contents 

Commands 

Using Help 

Premier Upgrade 

About PC Suite 

Intellisync 

Displays on-I ine Help Contents. 

Displays coiTITland information. 

Accesses Help for on-line Help. 

Displays lntellisync registration and 
Prerrier Upgrade subscription 
information. 

Displays" About PC &lite" dialogue. 
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File Transfer Functions 

Chapter 4 · File Transfer Functions 

The PC SJite File Transfer functions let you 
rrove, copy, paste, rename, and delete Nokia 
911 0 Communicator and PC fi I es and folders in a 
fami I i ar V\A ndows Explorer-type environment. 

Topics in this chapter include: 

+ Using the File Transfer Functions 

+ File Transfer Window Panes 

+ Selecting Files 

+ Copying Files and Folders 

+ Moving Files and Folders 

+ Deleting Files and Folders 

+ Renaming Files and Folders 

+ File Properties 

+ File Transfer Menu Commands 
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Using the File Transfer Functions 

Unlike Windows 
Explorer, you cannot 
launch a program or 
open a file from the File 
Transfer screen. 
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The PC Suite File Transfer functions let you move, copy, paste, 
rename, and delete Nokia 9110 Communicator and PC files and 
folders in a familiar Windows Explorer-type environment. 

Note: Built-in conversion utilities for some types of files allow 
you to transfer "incompatible" files between your communicator 
and your PC in a readable form. Files that are converted 
include: Nokia 9110 Communicator Notes files, communicator 
Fax files, and PC TIFF files (compressed in Group 3 (I d) Fax 
format). 

Follow these steps to access the PC Suite File Transfer functions. 

1. Start PC Suite and click the File Transfer icon in the 
opening screen. 

2. Connect your communicator to your PC COM port or 
establish an infrared connection. If you are prompted to do 
so, enter a name for your communicator. 

.Eile Edit ~iew Col!Jli:men':s JJpl:ion:s Help 

I File Transfer 
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1•1 
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1•1 DocS POCK 
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Hululu_OOOO 
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HuntersoOOO 

lmper1al 000 
Larry_OO DOD 
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Shift-click or Ctrl­
click also selects 
multiple files or 
folders. 

If press the Ctrl key 
while you drag the 
item, the item is 
removed from its 
original location. 

File Transfer Functions 

File Transfer Window Panes 
The File Transfer screen looks very similar to Windows 
Explorer. It is divided into two panes that can be re-sized by 
dragging the splitter bar that separates them. 

Drives and folders for both the Nokia 9110 Communicator and 
your PC are listed on the left, and can be expanded by clicking 

the + icon. The contents of the drive or folder highlighted on the 
left are shown on the right side of the window. 

Selecting Files 
Standard Windows file selection methods are used to select files 
or folders in the File Transfer screen. You can select an item by 
clicking on it with your mouse, or using the up and down arrow 
keys on your keyboard. 

Use the Shift key in combination with the up and down arrow 
keys to select multiple adjacent items. 

Copying Files and Folders 
Files and folders can be copied in the File Transfer window 
using "drag and drop" or by copying and pasting. 

To Drag and Drop: 
1. In the left pane, highlight the drive or folder containing the 

item you want to copy. 

2. In either pane, select the item(s) you want to copy. 

3. Hold the left mouse button down, and drag the item(s) to 
the new location. A + next to the cursor shows that you're 
copying (and not cutting) the item. 

4. Release the mouse button. 
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Keyboard Shortcuts: 

Ctri-C = Copy 

Ctri-V = Paste 

Note that the use of the 
Ctrl key in drag and 
drop operations is not 
identical to its use in 
Microsoft Explorer. 

You cannot cut read-only 
files or root folders from 
the communicator. 
Cut/Paste operations for 
these files/folders are, in 
effect, Copy/Paste 
operations. 

Keyboard Shortcuts: 

Ctri-X = Copy 

Ctri-V = Paste 
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To Copy and Paste: 
1. In the left pane, highlight the drive or folder containing the 

item you want to copy. 

2. In either pane, select the item(s) you want to copy. 

3. Select Copy from the Edit menu, or click the right-mouse 
button choose Copy from the pop-up menu. 

4. Highlight the left-pane drive or folder to which you want to 
copy the file. 

5. Select Paste from the Edit menu, or click the right-mouse 
button and choose Paste from the pop-up menu. 

Moving Files and Folders 
Files and folders can be moved in the File Transfer window 
using "drag and drop" or by cutting and pasting. 

To Drag and Drop: 
Use same drag and drop technique described previously for 
copying. However, you must press the Ctrl key while dragging. 
If you do not, the file or folder will not be removed from its 
original location. 

To Cut and Paste: 
1. In the left pane, highlight the drive or folder containing the 

item you want to cut. 

2. In either pane, select the item (or items) you want to cut 

3. Select Cut from the Edit menu, or click the right-mouse 
button choose Cut from the pop-up menu. 

4. Highlight the left-pane drive or folder to which you want to 
move the file or folder. 

5. Select Paste from the Edit menu, or click the right-mouse 
button and choose Paste from the pop-up menu. 

Verizon Wireless 
Exhibit 1035-0096 



Multiple items 
can be deleted at 
once in the right 
pane. Only one 
item at a time 
can be deleted 
from the left 
pane. 

File Transfer Functions 

Deleting Files and Folders 
There are three ways to delete an item from the left or right 
pane of the File Transfer window: 

Select the item you want to delete. Then: 

+ Press the Del key 

+ Select Delete from the Edit menu, or 

+ Press the right mouse button and choose Delete from the 
pop-up menu. 

Note: You cannot delete root folders or read-only files from the 
communicator. 

Items deleted from your PC are sent to the Windows Recycle 
bin. 

Renaming Files and Folders 
Just like in Windows Explorer, you can rename files and folders 
using the Rename command. 

To rename a file or folder: 

1. Select the file or folder you want to rename in either pane. 

2. Select Rename from the File menu, or click the right­
mouse button and choose Rename from the pop-up menu. 

3. Type a new name and then press Enter. 

Note: You cannot rename non-empty folders, root folders, or 
read-only files in the communicator. 
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When a Properties 
dialogue is displayed 
for a communicator 
file or folder, check 
boxes are disabled 
(greyed). You cannot 
change the attributes 
of a file or folder in 
the communicator. 
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File Properties 
Like Windows Explorer, the PC Suite File Transfer function 
lets you display and edit a file or folder's "properties." 

Follow these steps: 

1. Select a file or folder in either pane. 

2. Select Properties from the File menu, or click the right­
mouse button and choose Properties from the pop-up 
menu. This displays the Properties dialogue. 

Help1 rtf Propertres 13 

General 

[lliJ Help1 .rtf 

TJ>pe: RTF File 

Location: Help 

Size: 1 48.311 b)'tes 

MS·DOS name: HE LP1. RTF 

Created: Thursda)'. February 05. 1 998 11 :013:55 AM 

Modified: Monday. M arcll 02. 1 998 1 2:28:18 PM 

Acces•ed: Monday. April13. 1898 

Attributes: Higden 

OK 

Check or un-check the check boxes in this dialogue to change a 
PC file or folder's attributes. 

+ Click OK to save changes and exit the dialogue. 

+ Click Cancel to exit without saving changes. 

+ Click Apply to save changes without exiting. 
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File Transfer Menu Commands 

I FILE 
Ex1t 

VIEW 

Status Bar 

Large Icons 

Small Icons 

List 

Details 

Arrange Icons 

Refresh 

EDIT 

Cut 

Copy 

Paste 

Select All 

Invert Selection 

I Exits PC &lite. 

Toggles status bar on and off. 

SNitches view to Large I cons rrode. 

SNitches view to Srall I con rrode. 

SNitches view to List rrode. 

SNitches view to Detai Is rrode. 

Lets you arrange icons by Name, Type, 
Size, or Date. 

Refreshes (updates) display. 

Cuts the selected fi I e or folder. 

Copies the selected fi I e or folder. 

Pastes the item that was cut or copied 
to the selected location. 

931 ects all the items in the open folder. 

Inverts the selection status of each fi I e 
i n the open folder. 
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COMPONENTS 

Contacts 

Intellisync 

File Transfer 

Backup/Restore 

Install/Remove 

Import/Export 

HELP 

Contents 

Commands 

Using Help 

About PC Suite 
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S:arts Contacts application corrponent. 

Accesses I ntell i sync corrponent. 

Accesses File Transfer component. 

Accesses Backup/Restore corrponent. 

Accesses I nstall /Remove corrponent. 

Accesses I rrport/Export corrponent. 

Displays on-I ine Help Contents. 

Displays command information. 

Accesses Help for on-line Help. 

Displays" About PC &lite" dialogue. 
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Chapter 5 : Backup and Restore 

This chapter discusses the PC SJi te Backup and 
Restore commands, which safeguard the data in 
your communi cat or. 

Topics include: 

+ Backing Up Your Data 

+ Restoring a Backup 

+ Backup/Restore Menu Commands 
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Backing Up Your Data 

To-do list records are 
included when you 
backup the Calendar 
application. 

When you configure a 
Backup operation, your 
configuration is saved 
when you run the 
Backup or exit the 
Backup tab. 
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Follow these steps to backup some or all of the data on your 
Nokia 9110 Communicator: 

1. Click the Backup/Restore icon in the PC Suite opening 
screen. 

2. Connect your communicator to your PC COM port or 
establish an infrared connection. 

If prompted to do so, enter a name for your communicator. 

IM §iM§Miffi@IFUI I I I , g. I.M:!ffl@J.I#1· . _jol[){l 

a II~Ba~c~ku~p~/~R~es~to~re~:::::::=::::§§§§§§§§:=~Pgc~s~uit~e,~ l 
Cont-"CCs Backup J Re~tore 

c 
ln telis_ync 

~ 
File 

Tramier 

Beckup/ 
Re:.tore 

~ 
lmtal / 
Remo11e 

Import / ,_, 

NOKIA 

I Read.\' 

P" bL~-~-~i-~-~-~~ 
r ~elected device da ta 

I 

[; b;al e r;~da data 

r. Cofjtact 

r; QOCIJmerriS 

N.!,Jmber of backup ~tores 

_j ~"W" . I 

~13 

Bec~up 
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The Selected device 
data option does not 
backup settings and 
add-on applications. 

Using the Browse 
button to specify the 
Backup path prevents 
you from making 
typographical errors. 

Backup and Restore 

The Backup dialogue contains check boxes labelled All device 
data, Selected device data, and Memory card data. 

All device data, when checked, backs up Calendar and 
Contact data, documents, settings, and add-on applications. 

Selected device data, when checked, enables three 
additional check boxes. You can select any or all of these 
options. 

Calendar data: Backs up your Calendar data, including 
both Calendar and To do list records. 

Contact: Backs up Contact records. 

Documents: Backs up communicator documents. 

Memory card data: Lets you include data in your Nokia 
9110 Communicator Memory Card in the backup. If you do 
not check this option, Memory Card data is excluded from 
the backup. 

3. Using the check boxes in the Backup dialogue, specify the 
data to backup. 

4. In the box labelled Backup Path, specify the location (path) 
where you want backups stored. The backup name, 
Nokia9110Backup, is assigned automatically. 
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Number of Backup Stores 

The PC Suite Backup command creates multiple, sequentially 
numbered backups-e.g., Noki a911 0Backup01, 
Noki a911 0Backup02, Noki a911 0Backup03, and so on. 

Noki a911 0Backup01 is always the most recent backup. 

The maximum number of backups stored is determined by the 
value entered in the box labelled Number of backup stores. The 
default value is 3. You can enter any number between 1 and 99. 

Note: If you change this number before creating a new backup, 
existing backups will be deleted if the number you enter is less 
than number of existing backups. For example, if you have 10 
existing backups, and you change the number to 5, the five oldest 
backups will be deleted when you create the new backup. 

5. Enter a number between land 99 in the box labelled 
Number of backup stores. 

6. Click the Backup button to execute the Backup operation. 

If you're using a desk stand with your communicator, refer to 
Desk Stand Button Settings, in Chapter 1, for information on 
how you can program your desk stand button to run the currently 
configured Backup operation. 
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Restoring a Backup 

A single Restore 
operation can restore 
an entire backup (e.g., 
Nokia911 OBackup 01) 
or one backup 
component (e.g., 
Contacts). 

When there is no active 
connection between 
your communicator and 
PC, the Restore button 
is disabled in the 
Restore tab. 

Follow these steps to restore a backup to your communicator: 

1. Start PC Suite and click the Backup/Restore icon. Then 
click the Restore tab in the opening screen. 

2. Connect your communicator to your PC COM port or 
establish an infrared connection. 
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The Restore dialogue lists all the backups in the specified 
Backup directory. Nokia9110Backup01 is always the most recent 
backup in the specified location. 

3. If necessary, specify the location of the backup in the text 
box labelled Backup store. (The location of the last-created 
backup is entered by default.) 

4. In the lower portion of the dialogue, click on the data you 
want to restore. 

You can select an entire backup (e.g., Nokia9110Backup01), 
or one component of a backup (e.g., Contacts). If you want to 
restore more than one component, but not the entire backup, 
you'll need to run multiple Restore operations. 

5. Click Restore to restore the backup to your communicator 
and exit the Restore dialogue. 

Note: If you want to delete a backup or backups, you can do so 
in Windows Explorer or in the PC Suite File Transfer dialogue. 
Refer to "File Transfer Functions" in this chapter for 
information about PC Suite File Transfer functions. 
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Backup/Restore Menu Commands 

I FILE 
Ex1t 

VIEW 

Status Bar 

COMPONENTS 

Contacts 

Intellisync 

File Transfer 

Backup/Restore 

Install/Remove 

Import/Export 

OPTIONS 

Desk Stand Button 
Settings 

Registered 
Communicators 

Preferences 

HELP 

Contents 

Commands 

Using Help 

About PC Suite 

I Exits PC &lite 

Toggles status bar on and off. I 

S:arts Contacts application corrponent. 

Accesses I ntell i sync corrponent. 

Accesses File Transfer component. 

Accesses Backup/Restore corrponent. 

Accesses I nstall /Remove corrponent. 

Accesses I rrport/Export corrponent. 

Displays desk stand button options. 

Lists the communicators that have 
been connected and named. 

Displays the Preferences dialogue. 

Displays on-I ine Help Contents. 

Displays command information. 

Accesses Help for on-line Help. 

Displays" About PC &lite'' dialogue. 
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Installing and Removing Software 

Chapter 6 · Installing and Removing Software 
PC SJi te' s Install /Rerrove S:>ftware function I ets 
you install software to and rerrove software from 
your Nokia 911 0 Communi cat or's main merrory or 
merrory card. 
Topics include: 

+ Installing Software on your Communicator 

+ Removing Software from your Communicator 

+ Install/Remove Menu commands 

Page 101 

Verizon Wireless 
Exhibit 1035-0109 



PC Suite for Nokia 9110 Communicator 

Installing Software to your Communicator 
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Follow these steps to install a software package to your 
communicator: 

1. Start PC Suite and click the Install/Remove icon in the 
opening screen. 

2. Connect your communicator to your PC COM port or 
establish an infrared connection. 

If prompted to do so, enter a name for your communicator. 

3. In the Select Path text box, enter the path (location) of the 
software you want to install. Use the Browse button to 
quickly locate the software. 

4. Click on the software you want to install in the box below. 

5. In the Install Location box, select Communicator's 
memory or Memory card to specify where you want the 
software installed. 

6. Click the Install button. 
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Removing Software from your Communicator 

An icon next to each 
software package 
shows whether the 
software is located in 
your communicator's 
main memory or on a 
memory card. 

The ~ icon represents 
software in your 
communicator's main 
memory. 

Follow these steps to remove a software package from your 
communicator: 

1. Start PC Suite and click the Install/Remove icon in the 
opening screen. 

fii PC Su1le fo1 Nok1a 9110 Commumcalo1 Install/ Remove ~~[£1 
File Wid Fj!!dd !m~ge Groups Tools Help 

c 
lnl:ellis}'nc 

~ 
F" 

Tr<n>fer 

Brl.~/ 
Re!Jore 

lnstell/ 
R""'"" 

To remo11e M item, udecl ~ from th e ~~ end click Remove 

D PC 8-CerdViewer Librar_y 

M '-----------===-'1 
RMdo) DOl"' d 

2. Connect your communicator to your PC COM port or 
establish an infrared connection. 

If prompted to do so, enter a name for your communicator. 

3. Click on the software you want to remove in the box below. 

4. Click the Remove button. 
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Install/Remove Menu Commands 

I FILE 
Ex1t I Exits PC &lite. 

VIEW 

Status Bar Toggles status bar on and off. 

COMPONENTS 

Contacts S:arts Contacts application corrponent. 

Intellisync Acces'i!eS I ntell i sync corrponent. 

File Transfer Acces'i!eS File Transfer component. 

Backup/Restore Acces'i!eS Backup/Restore corrponent. 

Install/Remove Acces'i!eS I nstall /Remove corrponent. 

Import/Export Acces'i!eS I rrport/Export corrponent. 

OPTIONS 

Desk Stand Button Displays desk stand button options. 
Settings 

Registered Lists the communicators that have 
Communicators been connected and named. 

Preferences Displays the Preferences dialogue. 

HELP 

Contents Displays on-I ine Help Contents. 

Commands Displays command information. 

Using Help Acces'i!eS Help for on-line Help. 

About PC Suite Displays" About PC &lite'' dialogue. 
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Chapter 7 : Importing and Exporting 
Calendar and Contacts Files 

The PC SJite I mporUExport operations can be used 
to transfer Calendar and Contacts fi I es between 
your Nokia 9110 Communicator and your PC. 

Topics in this chapter include: 

+ The Import/Export Commands 

+ Exporting a Calendar or Contacts File to your PC 

+ Importing a File from your PC to your Communicator 

+ Importing a Contacts File 

+ Import/Export Menu Commands 
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The Import/Export Commands 

The File Transfer 
functions described in 
Chapter 4 cannot be 
used to transfer 
Calendar and 
Contacts files between 
your two system. 

Refer to Chapter 1 for 
information on using 
the Contacts 
application. 
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The PC Suite Import/Export operations transfer Calendar and 
Contacts files between your communicator and your PC. 

Tip: Communicator Contacts files are compatible, field-for-field, 
with the Contacts application that is included in PC Suite for 
Nokia 9110 Communicator. This Import/Export feature is useful 
as a means of transferring Contacts files between your Nokia 
9110 Communicator and PC Contacts application. 

File Import/Export vs. Intellisync Import/Export 

It's important to note how the Import and Export capabilities 
described here are distinct from the Intellisync Import and 
Export capabilities described in Chapter 3's "Importing and 
Exporting Data" (Under "lntellisync Special Topics"). 

Intellisync Import and Export operations transfer field-level data 
between your communicator and PC. Source records are merged 
with existing records, and "conflict resolution" is applied when 
both systems have similar but conflicting data. 

PC Suite's File Import/Export functions transfer entire files 
between your two systems. With one exception (see Importing a 
Contacts File later in this chapter), there is no merging of 
records or comparison of fields. 
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Exporting a Calendar or Contacts File to your PC 

Before performing an 
export, be sure to 
read "Import/Export 
vs. lntellisync 
I mport!Export" at the 
beginning of this 
chapter. 

The PC Suite Export function exports Calendar and Contacts 
files from your communicator to ASCII (.txt) files on your PC. 

Contacts files created by this function are compatible with the PC 
Suite Contacts application. Both Calendar and Contacts files can 
be read or edited using any text editor. 

Follow these steps to export a Calendar or Contacts file from 
your Nokia 9110 Communicator to your PC. 

1. Start PC Suite and click the Import/Export icon in the 
opening screen. 

2. Connect your communicator to your PC COM port or 
establish an infrared connection. 

If you are prompted to do so, enter a name for your 
communicator. 

3. Click the Export tab. 
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To avoid making 
typographical errors, 
click the Browse button 
and use the file browser 
to specify file paths. 
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4. Choose one of three options: Calendar data; Contacts; 
Contacts File on Memory Card. 

If you choose the last option, specify the path (location) of 
the Memory Card Contacts database you want to export. 

5. In the text box labelled Select the PC file to create, 
specify the name and path of the PC file you will create. (If 
you name an existing file, that file is overwritten when you 
run the Export.) 

6. Click the Export button to start the operation. 
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Importing a Calendar or Contacts File from your 
PC to your Communicator 

This function is 
primarily useful as a 
means of transferring 
Contacts application 
records to your 
communicator. 

Follow the steps below to import a .txt file to the Calendar or 
Contacts application on your Nokia 9110 Communicator. 

Note: Before performing an import, read "Importing a Contacts 
File," which follows. 

1. Start PC Suite and click the Import/Export icon in the 
opening screen to display the Import tab. 

2. Connect your communicator to your PC COM port or 
establish an infrared connection. 

If prompted to do so, enter a name for your communicator. 

3. Choose one of three options: Calendar; Contacts; Contacts 
File on Memory Card. 
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This Import function 
yields the same result 
as the Contacts 
application's Update to 
Communicator 
command. 
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+ If you select Calendar, the file you specify replaces the 
Calendar file in your communicator's main memory. 

+ If you select Contacts, the existing Contacts file is 
updated with records from your PC file. 

+ If you select Contacts Fi I eon Memory Card, you must 
specify a memory card filename. If you name an 
existing file, the file is updated with records from your 
PC file. 

4. Specify the PC file that you want to transfer to your 
communicator. To avoid making typographical errors, click 
the Browse button and use the file browser to select the 
file. 

5. Click the Import button to start the operation. 

Importing a Contacts File 
The Import function, when applied to a Contacts file, merges 
records from a PC Contacts file into the existing Contacts file 
in your communicator. 

During the merging process, records in your two systems are 
compared, and records that exist in your PC Contacts file that 
do not exist in your communicator are transferred to your 
communicator. 

Note that if a record in your PC Contacts file is almost, but not 
quite identical to a record in your communicator, the record is 
transferred. This means, for example, that if each of your 
systems has a Contact card for John Johansen, but the phone 
numbers in the two cards are different, a duplicate card 
(containing a different phone number) is created in your 
communicator. 

If you want to synchronise the Contact records in your two 
systems and avoid the possibility of creating "duplicate" records 
containing conflicting data, use the Intellisync synchronisation 
function described in Chapter 3. 
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Import/Export Menu Commands 

I FILE 
Ex1t 

VIEW 

Status Bar 

COMPONENTS 

Contacts 

Intellisync 

File Transfer 

Backup/Restore 

Install/Remove 

Import/Export 

OPTIONS 

Desk Stand Button 
Settings 

Registered 
Communicators 

Preferences 

HELP 

Contents 

Commands 

Using Help 

About PC Suite 

I Exits PC &lite. 

Toggles status bar on and off. I 

S:arts Contacts application corrponent. 

Accesses I ntell i sync corrponent. 

Accesses File Transfer component. 

Accesses Backup/Restore corrponent. 

Accesses I nstall /Remove corrponent. 

Accesses I rrport/Export corrponent. 

Displays desk stand button options. 

Lists the communicators that have 
been connected and named. 

Displays the Preferences dialogue. 

Displays on-line Help Contents. 

Displays command information. 

Accesses Help for on-line Help. 

Displays "About PC Suite" dialogue. 
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Index 
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B 
Backup Dialogue, 95 
Backup/Restore Icon, 7 

c 
Choose Translator Dialogue 

Apply to all applications 
checkbox,39 

Conununications Port 
Setting, 8 

Contacts Application 
adding contact cards to, 16 
adding pictures to Contact 

cards, 20 
and updating 

communicator records, 
27 

Card menu conunands, 16 
creating a card template, 

15 
creating and editing 

contact groups, 21 
editing contact card fields, 

17 
editing contact cards, 1 7 
finding a contact, 22 
main screen, 14 
opening a database, 15 
saving a database, 15 

Contacts Icon, 7 

D 
Desk Stand Button Settings, 

11 

E 
Exporting Data From Your 

Conununicator, 70 

F 
File Tab, 36 
File Transfer Functions, 86 

copying files and folders, 
87 

deleting files and folders, 
89 

moving files and folders, 
88 

properties, 90 
renaming files and folders, 

89 
selecting files, 87 

File Transfer Icon, 7 
File Transfer Window Panes, 

87 
First-Run Synchronisation, 

79 
Full Re-Synchronisation, 80 

I 
Icons 

help, 5 
PC Suite, 5 
readme, 5 
uninstall, 5 

Import/Export Icon, 7 
Importing Data to Your 

Conununicator, 70 
Install/Remove Icon, 7 
Intellisync 

and Freeform Fields, 67 
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Intellisync, 33 
Additional Details 

Dialogue, 49 
address formats, 35, 67 
Advanced Button, 39 
Advanced Settings 

dialogues, 42 
and data truncation, 63, 71 
Choose Translator 

dialogue, 36 
Conditions Tab, 56 
Configuration Dialogue, 

36,38 
Confirmation Prompt, 46, 

47,48, 72 
Conflict Resolution tab, 

50 
Conflict Resolution, 66, 

78 
Conflict Resolution 

Dialogue Box, 52 
Conflict Resolution 

Options, 52 
data conflict, 50, 78 
Date Range, 44 
Date Range Tab, 43 
Details Dialogue, 48 
fanning of repeating items, 

79 
Field Mapping Dialogue, 

61 
Filters Tab, 55 
First Run 

Synchronisations, 40 
first-run synchronisation, 

79 
Full Re-Synchronisation, 

72,80 
glossary, 78 
history files, 66 
how synchronisation 

works, 66 

Import and Export 
operations, 70 

Key Fields, 51 

Index 

letter case in key fields, 51 
notes on conflict 

resolution, 54 
Notify Conflict Resolution 

option, 52 
Options dialogue, 37 
Re-Sync Button, 72 
Rules Tab, 57 
Same Record Changed and 

Deleted Dialogue, 73 
Sync Log File, 74 
Taskbar Synchronisation, 

40 
To Do Range, 45 
tutorial, 34 

Intellisync Advanced Settings 
Dialogue 
Confirmation tab, 46 
Date Range tab, 43 
Field Mapping, 61 
Filters tab, 55 
To-do list tab, 45 

Intellisync Buttons 
Re-Sync, 72 

Intellisync Confirm Record 
Deletions, 72 

Intellisync Contacts 
synchronising memory 

card Contacts file, 36 
Intellisync Data Conflict, 78 
Intellisync Field Mapping, 79 

asterisks in Field Mapping 
dialogue, 63 

default mapping, 62 
Freeform Fields, 64 
mapping non-adjacent 

fields, 62 
Intellisync files 

history files, 66, 80 
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sync log, 74 
Intellisync Filters 

Add to List button, 58 
and logical operators, 57 
Conditions tab operators, 

59 
creating, 58 
notes, 60 
Update Button, 58 

Intellisync Filters Tab, 55 
Intellisync Glossary, 78 
Intellisync History Files, 40, 

66,80 
Intellisync Icon, 7 
Intellisync Settings 

Date Range setting, 43 

p 

PC Contacts Application 
JPEG files, 41 

Preferences Dialogue, 8, 12 

R 
Readme File, 5 
Remote Synchronisation 

vs. local synchronisation, 
76 

Restoring Backups, 97 

s 
Sync Log File, 74 
Synchronisation 

and data truncation, 71 
first-run, 79 
Same Record Changed and 

Deleted, 73 
System Requirements, 3 

T 
Translator, 81 

u 
Intellisync Field Mapping, 62 
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